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Catherine Ellis
Operations Editor
Cat has jetpacked 
across a virtual 
Brazil in Firefall.
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Commissioning Ed
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immediately.
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on his motorbike, Nick has 
been using Bing Travel.

This month...

Graham Barlow Editor-in-Chief
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The announcement of Windows 
10 (the finished version is due out 
around the middle of next year) 
has taken everyone by surprise. 
Given that the last two versions 
of Windows were called 7 and 8 
respectively, we were expecting 
Windows 9, but instead Microsoft 
has skipped a generation and 
gone straight to 10. On the 
surface it looks like a hybrid of 
Windows 7 and 8, which isn’t 
such a bad thing, and you can 
find out more about it in our 
feature on page 68. Windows 8 

had some very good ideas, and it 
looks like Windows 10 is going to 
reap the benefits by making 
Windows easier to use. 

We’ve got some news of our 
own, too. To reflect all the 
different versions of Windows 
we’ve decided to rename our 
magazine – with Windows 10 on 
the horizon it makes sense for us 
to become Windows Help & 
Advice, so we can cover all 
versions. I’ll see you next 
month for more exciting 
Windows news. 

Welcome

SUBSCRIBE & SAVE TODAY TO START  
GETTING MORE FROM WINDOWS!

We pride ourselves in being the only magazine 
on the shelves to show you exactly how to get 
the best from the Windows operating system, 
whether it’s 7, 8, 10, Vista or even XP. Windows  
Help & Advice also comes with a disc, on  
which you can find some of the great apps 
covered in the magazine. If you get a chance, 
take a look at how you can even read the 
magazine on your laptop, phone or tablet.



6 Discover Prevent your private 
information falling into the wrong hands

27 Next month Gaze into the 
future… What’s happening at Christmas?

30 Subscriptions Save up to 35 
per cent when you subscribe today!
 
38 Reader offers We’ve a selection 
of money-saving deals just for you
 
73 Overseas reader? Get your 
mag for less with a subscription 
 

74 Four pages of essential 
expert help for all your 
tricky technical queries

ReGulaRS

FeatuReS

SuPPoRt

12 Windows problems solved 
tips and techniques to get your  
computer running perfectly again

60 New things your PC can do
Push your PC to the limit and discover  
the breadth of tasks it can perform
 
68 Introducing Windows 10 
Microsoft takes the wraps off the next 
version of its operating system

exPloRe  
The best PC tutorials

Want more? Visit our website at 
www.facebook.com/windowsmag

24 use Paint.Net to fix  
problems with photos

28 Send files to friends  
and family using Skype

32 Slim down Windows 7  
for faster performance

36 Improve ‘snapping’  
Windows with Windock

40 Make your own  
PC games with Kodu 

44 Supercharge your  
Windows 8 PC

46 Rename media files  
quickly and easily

50 Master the Windows  
action Center

52 Keep an eye on your  
home wireless network

56 extend your laptop’s  
battery life 

Your guide Graham Barlow says…
“each month we include as wide a range of tutorials 
as possible, to help you use your computer more 
efficiently and inspire you to try new things.”
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 NEW thiNgs to do  amaziNg WEbsitEs  fasciNatiNg facts

Precious cargo We now store more of our 
important files online than ever before, so it’s 
essential to keep them well protected
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The Knowledge…

‘Phishing’ refers to fake emails and 
websites designed to make you part 
with financial information or personal 
details. They’re dubbed ‘phishing’ because 
they involve sending out messages to 
millions of people in the hope that 
one will ‘bite’. According to antivirus 
company Kaspersky, 37.3 million people 
experienced attacks last year. However, 
it’s easy to avoid being conned by being 
cautious and knowing what to look for.

Avoid your data falling 
into the wrong hands

Safe and secure

B
arely a day goes by without 
some form of hacking making 
front page news, whether it’s 
governments spying on their 

own citizens or celebrities having 
supposedly private pictures leaked to 
the internet. This makes storing your 
information online seem like a very scary 
thing to do, but fortunately there are a 
number of steps you can take to keep 
hackers and other criminals away from 
your most important 
bits of data.

To make the 
internet more secure, 
the majority of big 
companies that store 
your data now include two-step 
authentication. As its name suggests, this 
requires you to prove your identity in two 
ways before you’re allowed access to your 
data. Google, which pioneered the service, 
asks for your password and then sends 
a special code to your phone as a text 
message, which you enter when you want 
to access your account. It’s a simple but 
extremely effective way of securing your 

information, and you can enable it from 
your account settings.

Secure passwords are also a powerful 
defence in the battle against online 
intruders. Common passwords such as 
‘12345’ and ‘password’ are the first that 
hackers try, so avoid these. Instead, go for 
combinations of letters and numbers, such 
as “L4D2imfg.” Although that might seem 
hard to remember, it actually stands for 
‘Left 4 Dead 2 is my favourite game’, and 

you can use similar 
abbreviations to 
create unguessable 
passwords. Make 
sure you use a 
different password 

for each site you visit, and update them 
periodically for added security.

Finally, keep an eye on the Windows 
Taskbar to the lower right of the screen. 
You’ll see any critical updates here, and 
they can be installed with a right-click. 
This is also where you’ll see alerts from 
your antivirus software, and it’s important 
that this stays up to date (although most 
security tools do this automatically now).

We show you the simple steps you can take to make sure 
your precious files and documents are tightly locked away

Apple Watch
is this a new website to stay up to date 
with apple’s latest developments?
No, although the internet is stuffed with 
such sites. The Apple Watch is – as the 
name suggests – a wristwatch made by 
Apple. It was announced alongside the 
new iPhones, and it marks Apple’s first 
venture into the exciting new world of 
wearable technology.

i’m not sure i like the look of it.
Apple has gone to great lengths to make 
sure there’s a Watch for everyone. Once 
you’ve chosen between the 38mm and 
42mm housings, you can pick a material 
(including stainless steel, aluminium and 
even 18-karat gold), select a strap, and 
then customise the face with backdrops 
and themes.

sounds tempting. What does it do?
It’s effectively a touchscreen phone on 
your wrist. This means you can use it to 
get directions and view maps, talk to 
friends with simple communications 
(called ‘Yo’), sketch little drawings and use 
it like a walkie-talkie – all without taking 
your phone out of your pocket.

anything else?
Apple has employed some clever 
technology and health apps to measure 
your heartrate, and it can detect and 
record everything you’re doing, whether 
you’re sitting down or competing in a 
marathon. It will even tell you what time  
it is!

okay, i’m interested. When can i get one, 
and how much will it cost?
Apple plans to launch the Apple Watch 
early next year. The US price tag is $349, so 
assuming it follows Apple’s usual pricing 
model, we expect it to cost around £250 
in the UK. The caveat is that you’ll need 
an iPhone 5 or above to pair with it (some 
features only work when the handset is 
within range), which will add to the price if 
you don’t already own one.

sPam most online email providers, such as gmail 
and Hotmail, put emails into your spam folder 
automatically, so if it’s in there, beware!

urLs ensure the address in your browser’s address 
bar matches the site you’re meant to be looking at.

attacHments Don’t open attachments unless 
you’re sure you know who the message is from.

The big phish How to avoid online scams

“there are steps you can 
take to keep hackers 
away from your data”

Discover
Online security
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HENRY WINCHESTER 

TECH EXPERT

Tip of the month JDiskReport

Struggling to get something to work? Need a tip? 
Then email us your woes (to windowsmagazine@futurenet.com with the subject line 
‘Windows Insider’) and we’ll share your perfect Windows tweaks in a future issue.

Over time your hard drive can accumulate a 
lot of useless files, which can have a knock-on 
effect on how well your computer performs. 
Most of these files are stored in temporary 
directories, which makes them hard to find, 
but fortunately Windows Vista’s Disk Cleanup 
makes it easy to remove all the excess junk. 
To use it, click ‘Start > Accessories > System 
Tools > Disk Cleanup’. You’ll now see a series 
of files to be deleted – check the tickboxes to 
choose categories of files to delete, and use 
the ‘View files’ button to see what’s going 
to go. ‘More options’ lets you know which 
programs aren’t being used, and ‘System 
Restore and Shadow Copies’ removes all 
backups apart from the most recent one.

Disk Cleanup

The launch of Windows 8 brought with it hot 
corners, which meant that hovering your 
cursor over the corners of the screen brought 
up instant menus. These were useful if you 
were using a touchscreen monitor, but on 
standard desktop computers they were 
intrusive and annoying. The Windows 8.1 
update removed some hot corners, but left 
the charm bar and app switching - but these 
can be switched off too. Go to the desktop 
view, then right-click on the Taskbar and 
choose ‘Properties > Navigation’. Now use 
the checkboxes to turn off the charm bar 
and the recent apps menu.

Turn off hot cornersInstalling new programs or changing settings 
on a standard Windows 7 installation is often 
done via the well-meaning but slightly 
annoying User Account Control system. This 
is designed to let you know that something is 
about to change on your computer, giving 
you an extra layer of security and peace 
of mind. If you’re a computer novice we 
recommend leaving it on, but if you wish to 
turn it off it’s a painless process. Simply click 
the Windows Orb, then choose ‘Control 
Panel’ and type UAC in the search box to 
the upper right. Click ‘Change user account 
settings’ and you’ll see a slider. Drag this to 
the bottom to switch off all notifications, or 
to the top for maximum protection.

User Account Control

Although Disk Cleanup is a quick and 
easy way to delete common unused 
files, it lacks the ability to drill down 
and find what exactly is eating up your 
hard disk space, which is important if 
you’re using a small but fast solid state 
drive. JDiskReport solves this problem 
by analysing your hard drives or 
directories and then highlighting the 
biggest files, so you can find them and 
delete or move them.

To begin, visit www.jgoodies.com/
freeware/jdiskreport and download 
and install the software. Run it and use 
‘Scan a file tree’ to choose which drive 
or folders to scan. After you’ve run it 
you’ll see a pie chart that shows you 
where large files are lurking, and 
clicking larger slices takes you through 
the various sub-directories. You can 
then right-click a slice and click ‘Open 
Explorer’ to zap those huge files.

Clear your hard drive clutter
Ever wondered what’s taking up all the space on 
your hard drive? This brilliant app can show you

Final analysis The free DiskReport tool will also let you see 
what’s filling up your UsB drives and memory cards
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Download this…
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FRIDAY

November 2014
NEXT ISSUE ON SALE

21

Minecraft, the online building game 
which has sold over 54 million copies, 
has been bought by Microsoft for 
a whopping $2.5 billion. As well as 
procuring the rights to the game’s 
intellectual property, Microsoft will 
own its developer Mojang and its other 
games Cobalt and Scrolls. However 
Markus ‘Notch’ Persson, Minecraft’s 
creator and developer, will leave.

“Minecraft has grown from a simple 
game to a project of monumental 
significance,” said 
Mojang in a press 
release. “Though we’re 
massively proud of 
what Minecraft has 
become, it was never 
Notch’s intention for it 
to get this big. We’ve 
worked closely with 
Microsoft since 2012, and have been 
impressed by their continued dedication 
to our game and its development. We’re 
confident that Minecraft will continue to 
grow in an awesome way.”

Despite being just five years old, 
Minecraft has become a media empire 
unto itself. The game features a computer-
generated randomised world in which 
players build Lego-like buildings using 
mined materials. Its environments are 
also surprisingly hostile, and the player 
must ward off monsters.

While it sounds simple, Minecraft is 
nothing short of revolutionary. The game 
combines elements of role-playing titles 
such as The Elder Scrolls: Skyrim with 
open-world survival games like Day Z. 
At the same time it’s a game about making 
games, but its simple graphical style and 
easy-to-understand construction methods 
make it a lot easier than trying to modify 
a big budget blockbuster game.

But the real key to Minecraft’s success 
has been the way it’s accessible and fun for 

children. Its blocky, 
pixellated graphics 
are a world away 
from ultra-realistic 
first person shooters 
such as Call of Duty, 
and it’s built a large 
audience of pre-
teens. The huge 

range of merchandise available (annuals, 
toys, even Lego) is testament to just how 
much it’s been embraced by today’s youth.

Microsoft’s purchase of the company 
doesn’t mean that it’ll suddenly become a 
corporate-sponsored world, or that it will 
be reshaped into an Xbox-exclusive game 
– Microsoft, it seems, will leave Mojang to 
its own devices. As for Notch himself, he 
believes it’s the right time to escape. “I’m 
not a CEO,” he said in his leaving letter. 
“I’m a nerdy computer programmer who 
likes to have opinions on Twitter.”

The creator of Windows has paid $2.5 billion for the 
brick-building game – but why is it worth so much?

Gold mine?

1Which video 
game has been 

programmed to run on 

a Canon inkjet printer?

a) Super Mario Bros
b) Tetris
c) Doom

2What is the size of 

Sandisk’s ‘largest 

ever’ SD card?
a) 512GB
b) 1TB
c) 2TB

3 Sega’s latest arcade 

machine projects 

interactive images onto 

which material?
a) Putty
b) Sand
c) Wood

4 A university has 
released an app to 

identify which critters?

a) Spiders
b) Beetles
c) Woodlice

5 Facebook’s daily 
video views have 

exceeded which figure?

a) 250 million
b) 500 million
c) One billion

6 Scientists in India 
and France sent what 

via the internet?
a) A hydrogen molecule
b) Information directly 
from the brain
c) A photon

Pens at the ready, your time starts now!The 60-Second Quiz

Answers 1C, 2A, 3B, 4A, 5C, 6B

Microsoft buys Minecraft Print Friendly
www.printfriendly.com

Ever printed out a web page, only to 
be confronted by reams of useless 
advertisements and weirdly-formatted 
text? If so, Print Friendly is for you. Paste 
the address of the webpage you wish to 
print into this incredibly useful site, and 
it’ll strip out any advertisements and 
site-specific navigation. You can also 
preview the page, choose which images 
to print (or remove them all), cut out 
certain paragraphs and set the text size.
Once it’s ready to go, you can print it 
without using a huge amount of paper. 
It also saves you printer ink or toner, 
which can cost a small fortune. You can 
save pages as PDFs or send them as 
emails, too. This is useful if a site is badly 
laid out or hard to read, or if you want to 
share relevant information with others.

Waste paper print Friendly saves you time 
and money when printing web pages

Discover
Tech talk
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...of Americans are willing to have an in-person 
conversation about current affairs, compared to 
just 42 per cent who would be willing to discuss 
it on a social networking platform. The research, 
conducted by the Pew Research Internet Project, 
suggests that instead of hiding behind the 
anonymity of Facebook or Twitter, people would 
rather not discuss divisive issues such as 
the Edward Snowden hacking case at all, 
unless they were certain their friends 
or followers would agree with them.

86 per cent…

Which usurped 
activities do adults 
miss most?
It’s hard to imagine a time 
when we’d go to a shop to rent 
videos or wait for photographs 
to be developed, but these are 
both activities that feature in a 
list of things people miss from the 1990s. The 
research, commissioned by Disney to mark the 
beginning of TV series Girl Meets World, also 
includes ancient practices such as making tape 
recordings of the top 40 and having pen-pals. 

Some 52 per cent of the adults 
surveyed said they pined for 
the simpler times two decades 
ago, while presumably wearing 
heavily rose-tinted glasses.

Apple’s latest iPhones are indicative of 
a growing trend, with each iteration 
getting a little bigger. It shouldn’t 
come as a surprise – research 
from Kantar Worldpanel 
suggests that screen size is the 
first thing consumers look for 
when they’re buying a new 
phone. Design attractiveness, 
material quality and the ability 
to personalise the handset are all 
of lower priority. It does make us 
wonder just how huge phones are 
going to be in a few years’ time.

Why are 
smartphones 
getting bigger?

...of parents admit that they haven’t warned their children of the 
dangers of the internet, despite 74 per cent agreeing that 
it was their responsibility to keep their little ‘uns 
safe online. The research, conducted by OnePoll 
on behalf of Disney, found that parents felt 
comfortable discussing Father Christmas, swearing, 
and the birds and the bees, but didn’t know how 
to broach the subject of staying safe online.
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Henry Winchester reveals a host  
of fascinating digital facts

45 per cent…



One of the biggest dangers 
of the internet is that you’ll 
inadvertently find out who 

killed whom in the latest detective 
series, or the identity of the 
undercover mole in a spy movie. 
However, you’re more likely to 
experience spoilers as a result of 
careless friends or co-workers 
discussing the media. Only 49 per 
cent of respondents cited Facebook 
as a source of media ruinations, 
according to research by TiVo.

have you ever 
had a tv shoW 
or film spoilt?

the British broadsheet newspaper launched its web presence as 
Guardian unlimited in 1999 as part of its New media lab project.

in 2005, 2006 and 2007 the site scooped the Best Newspaper 
prize at the Webby awards, beating the New York Times and the 
Washington Post.

on march 14 2006 the Guardian launched comment is Free, a 
blog that hosts the thoughts of some 600 writers.

2006 was also the site’s first profitable year, with the majority of 
income coming from recruitment and display advertising.

the Guardian launched a us-specific site, Guardian america, in 
october 2007. the site was abandoned in 2009.

in october 2008 it became the first uK newspaper to attract 
more than 25 million unique users a month.

Between 2009 and 2010 it launched a range of new digital 
services, including iphone and ipad apps.

although it had usually played second fiddle to the mail online 
as the uK’s most popular newspaper website, in 2013 it claimed 
first place with 8.2 million unique British visitors per month.

Guardian Witness, its citizen journalism project, was relaunched 
in 2014 and put at the forefront of the site.

in 2014 historians from around the world were invited to 
contribute to a groundbreaking interactive documentary on the 
First World War.

Top facTs abouT 
guardian.co.uk

Which 
internet 
broWsers  
are most 
popular?

should you 
repair or 

replace broken 
technology?

a us repair company recently sat down 
and did the maths to see whether it’s 
worth repairing or replacing common 
items when they go wrong. according 

to lexicon technologies, it’s cheaper to 
get tablets and smartphones repaired 

than it is to replace them. desktop 
computers tend to have a lifespan of 

about four years, after which it’s better 
value to simply buy a new one. 

laptops, on the other hand, tend  
to cost more, so it’s more affordable to 

get them repaired if they break.

43.12%  
surf with Chrome

1.10% sing 
the praises 

of Opera

8.59%  
explore the 
wilderness 
with Safari

20.9%  
get online with 

Firefox

24.53% discover the web 
with Internet Explorer

Source: Waterfox

source: http://en.wikiepedia.org, www.guardian.co.uk, www.gmgplc.co.uk

Discover 
Facts & figures
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When you buy a new PC, it generally 
behaves very well. Your system boots 

and runs quickly, programs install without any 
problems and it all works just as you’d expect.

But then, quite often, things begin to 
change. Your computer starts to slow down. 
Odd things happen occasionally – some 
features stop working, for instance, and 
you can’t understand why. Some of your 
applications – and maybe Windows itself – 
may begin to display cryptic error messages, 
or perhaps crash occasionally. 

Some people say this is normal – it’s just 
the way PCs are, and you have to put up 
with it – but we say no. You don’t have to live 
with poor performance, desktop problems, 

misbehaving software and the many other 
hassles that might be troubling your system. 
You don’t need weeks of spare time and a 
degree in computer science to solve these 
issues, either – most can be tackled with 
surprising ease once you know where to get 
started. That’s where we come in.

We’ve put together 101 quick and easy 
solutions for some of the most annoying PC 
problems, covering everything from sluggish 
speeds and desktop deficiencies to boot 
problems, installation issues, cryptic error 
messages and more. So don’t just put up 
with Windows annoyances – take our advice, 
fight back, and you’ll soon have your system 
running smoothly again.

Suitable for: Windows 7
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01How can I tell 
what’s tying up 

my PC’s resources?
Click ‘Start’, type 
resmon and press 
[Enter] to find out 
what’s using your PC’s 
CPU, hard drive and 
internet connection.

02 It’ll take ages 
to move my 

files to a new PC!
Easy Transfer is a tool 
supplied with Windows 
that makes this very 
simple. Search for Easy 
Transfer in Windows 
Help for more details.

03 Why is my 
Wi-Fi so slow?

Run Xirrus Wi-Fi 
Inspector (from your 
free disc). If it shows 
interference from a 
nearby network, 
changing your wireless 
channel should help.

04 Navigating 
folders takes 

too long in Explorer
To see a folder you’ve 
used recently, just 
right-click the Explorer 
icon on your Taskbar 
and select it from your 
Jump List.

05How can I 
browse faster?

Using Namebench 
(http://code.google.
com/p/namebench) 
to find a faster DNS 
server can dramatically 
cut the time it takes to 
access websites.

Windows 7 tips 
101 Windows problems solved

December 2014  |    |  13



06Some folders take 
an age to open

Deleting any files you don’t 
need can sometimes help 
speed things up, but sorting 
out the folder’s properties 
usually delivers the best 
results. Right-click the folder, 
select ‘Properties > Customize’, 
set the ‘Optimize this folder 
for’ list to ‘General items’ and 
see how this works for you.

07My Explorer windows 
close when I reboot

In Explorer, click ‘Tools > 
Folder options > View’, then 
scroll down and check ‘Restore 
previous folder windows at 
logon’. When you next restart, 
any Explorer windows you had 
open before will appear again.

08The desktop clock 
isn’t accurate

An incorrect PC clock isn’t 
just annoying, it can also 
cause significant problems 
with networks and some 
applications that rely on it. 
If you notice yours is out, 
right-click it and select ‘Adjust 
date/time > Internet time > 
Change settings’. Check 
‘Synchronize with an internet 

time server’, then click ‘Update 
now’ to correct it.

10 It takes too long  
to find files

To find one file in a packed 
folder, you don’t have to scroll 
through the entire list. Either 
enter its name in the Search 
box, or just click in the blank 
area to the right of the list of 
files and begin typing its name 
here. Every time you hit a key, 
Explorer will jump to the first 
matching file. When the right 
one appears, you can press 
[Enter] to open it.

11I’m having trouble 
with the Start menu

If the Start menu is missing 
some feature you’re familiar 
with, perhaps from another 
PC, then click ‘Start’, right-click 
the ‘Shut down’ button and 
click ‘Properties > Customise’ 
to see a host of useful 
configuration settings (you 
can add the Run box to the 
menu, for instance). Tweak 
these settings to suit your 
needs, or click ‘Use default 
settings’ to restore the 
standard Windows behaviour 
if you prefer.

12 I’m bored with my 
desktop wallpaper

To change the look of your 
PC’s desktop, right-click an 
empty part of it and click 
‘Personalize > Get more 
themes online’. A browser 
window will open at the 
Windows Themes page, where 
you’ll find hundreds of themes 
on all kinds of topics – animals, 
art, games, movies, landscapes 
and more – and they’re all free 
to download.

13Explorer’s file icons 
are the wrong size

Click in the folder window, 
hold down [Ctrl] and spin your 
mouse wheel to cycle through 
every possible file view. It’s 
much quicker than having to 
choose the right option from 
Explorer’s menus manually.

14A program window 
has disappeared

If you can see a program’s 
button on the Taskbar but 
clicking it doesn’t display 
anything, this could mean 
that its window has been 
accidentally moved off the 
screen somehow. Press 
[Ctrl]+[Shift]+[Esc] to launch 
Task Manager, right-click your 
program in the Applications 
list, select ‘Maximise’ and it 
should reappear.

15Using the command 
line takes ages

Typing something like CD\
This\Is\A\Very\Long\Path can 
take a while, but there may 
be an easier way. Hold down 
[Shift], right-click the folder 
in Explorer, choose ‘Open 
command window here’ and 

09Extra programs appear 
when Windows starts

Start by launching these programs, checking their settings 
for an option like ‘Launch at startup’ and turning that off.

If that’s no help, click ‘Start > All programs’, expand the 
Startup folder, right-click any applications you’re sure you 
don’t need and select ‘Delete’. Alternatively, install and run 
CCleaner from your free disc, click ‘Tools > Startup > 
Windows’, select any programs that are surplus to 
requirements and click ‘Delete’ to remove them.

cmd.exe will open at that 
particular folder.

16How can I mute 
the startup sound?

Click ‘Start’, type sound, and 
click ‘Sound > Sounds’. Clear 
the ‘Play Windows Startup 
sound’ box if you don’t want 
to be alerted when your 
system has booted. You can 
also add a custom sound here 
(click ‘Browse’ and select it), 
and adjust other system 
sounds to suit your needs.

17Explorer opens at  
the wrong folder

By default, Explorer always 
opens at the Computer folder. 
To choose another location, 
right-click the Explorer 
shortcut, select ‘Properties’, 
click in the ‘Target’ box, press 
[Space] and enter your new 
path in quotes (it’ll read 
something like %windir%\
explorer.exe “d:\”).

18I find Windows Aero 
Snap annoying

If you don’t like the way 
windows reposition and resize 
themselves when moved to 
the edge of the screen, you 
can turn this feature off. Go to 
‘Control Panel > Ease of access’ 
and select ‘Change how your 
mouse works’ or ‘Change how 
your keyboard works’. Check 
‘Prevent windows from being 
automatically arranged when 
moved to the edge of the 
screen’ and click ‘OK’.

19Explorer is showing 
the wrong icons

Close Explorer, launch Disk 
Cleanup, choose your drive, 
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make sure ‘Thumbnails’ is 
checked and click ‘OK’. This will 
delete the Explorer thumbnail 
cache, which may get your 
folders displayed properly.
 

20I can’t find a 
particular setting

If you’re tired of browsing 
through Control Panel to find 

a particular option, just click in 
the Search box, press [E], and 
you’ll see all the settings in a 
single list that should be much 
easier to navigate.

22What have other 
users done to my PC?

If someone else has messed 
up your desktop then it can be 

useful to know exactly what 
they did, and LastActivityView 
(from your free disc or www.
nirsoft.net) can help, showing 
you programs they’ve 
run, files they’ve opened 
or saved, folders viewed, 
programs installed, network 
connections, start and 
shutdown times and more.

23My Taskbar’s system 
tray is too cluttered

Click the arrow to the left of 
the tray and select ‘Customize’ 
from the menu that appears. 
If there are any icons here that 
you’re sure you don’t need, set 
their behaviour to ‘Only show 
notifications’. If you decide you 
don’t need the clock or other 
standard items, click ‘Turn 
system icons on or off’ to 
disable them.

21I need more space on  
my Windows desktop

Right-click your desktop, select ‘Screen resolution’ and make 
sure you’re using the highest recommended setting. If you 
are, click ‘Start’, type personal and select ‘Personalization’. 
Click ‘Window Colour > Advanced appearance settings’, 
choose ‘Border padding’ and select a size of zero. You can 
also cut the size of menus, scrollbars and more, but beware 
– this might stop some programs working properly.

24Search is 
too slow

By default, Windows only 
indexes files stored in your user 
folders (Documents, Desktop, 
Pictures and so on), so searching 
elsewhere will take longer. 
Moving the documents you 
want to search into your user 
folders (from C:\MyFiles to C:\
Users\[Name]\Documents\
MyFiles) should speed things 
up, but you can tell Windows 
to index other folders as well. 

Click ‘Start’, type index and 
click ‘Indexing options’. Click 
‘Modify’, expand the tree and 
check the folders you’d like to 
be indexed (remember, the 
more files there are, the longer 
indexing will take). Click ‘OK’ 
when you’re done.

27 I accidentally 
deleted a file

If you make a mistake 
in Explorer (delete an 
important folder, for 
example, or move the 
wrong files), just press 
[Ctrl]+[Z] to undo your 
last action.

28I don’t want to 
use Explorer

Try Q-Dir (from your 
free disc or www.
softwareok.com). It has 
browser-like tabs, you 
can use it to save all 
your open folders and 
restore them later.

29 My icons aren’t 
arranged neatly

DesktopOK (on your 
free disc, or from www.
softwareok.com) lets 
you save your icon 
positions and restore 
them whenever you like 
with a couple of clicks.

30 My desktop is 
too cluttered

Just select the main 
program you want 
to use, then press 
[Windows]+[Home] 
and everything else 
on the desktop will be 
minimised immediately.

31 Text appears 
too small

If you can’t see some 
tiny detail, hold down 
the [Windows] key and 
press [+] to zoom in 
with the Magnifier. 
Hold [Windows] and 
press [-] to zoom out.

25I can’t see thumbnails 
for all my video files

Click ‘Tools > Folder Options > 
View’ and make sure ‘Always 
show icons’ isn’t checked. If 
that doesn’t help, install Media 
Preview (from your free disc or 
www.babelsoft.net/products.
htm) and it will add thumbnail 
support for all the main video 
file types.

26I need a list of the 
files inside a folder

Hold down [Shift], then 
right-click the folder you’re 
interested in and select ‘Open 
command window here’. Type 
dir /b | clip, then press [Enter] 
and the names of the files in 
your folder will be copied to 
the clipboard so you can paste 
them wherever you like (a 
Word document, for example).
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32An old program 
won’t run on my PC

Hold [Ctrl]+[Shift], right-click 
the program, select 
‘Troubleshoot compatibility’ 
and Windows will launch a 
wizard to try to help. If you’re 
having trouble running old 
DOS games, try DOSbox (from 
your free disc or http://dosbox.
sourceforge.net). It’s a great 
way to run ageing programs 
on modern hardware.

33What does this 
error code mean?

Error messages are sometimes 
unhelpful, displaying some 
cryptic code like 0x00000653. 
Entering these into the 
Windows Error Lookup Tool 
(from your free disc or www.
gunnerinc.com/welt.htm) can 
provide more information.

34Windows Update 
reboots my PC

Launch REGEDIT and browse 
to HKEY_LOCAL_MACHINE\
SOFTWARE\Policies\Microsoft\
Windows\WindowsUpdate\AU 
(create the last two keys 
yourself if necessary). Create a 
DWORD (32-bit) value called 
NoAutoRebootWithLogged 
OnUsers. Double-click this, 
give it the value 1, and your 
PC won’t be rebooted again.

35Internet Explorer 
doesn’t start

Click ‘Start > All programs > 
Accessories > System tools > 
Internet Explorer (no add-ons)’. 
If IE now launches properly 

then you probably have 
a broken add-on. Restore 
extensions as you need them 
by clicking ‘Tools > Manage 
add-ons’, then right-clicking 
and selecting ‘Enable’. When 
you find the one responsible 
for your problems, uninstall 
or reinstall it separately.

36 I can’t close a 
particular program

If you can’t close an 
application from Task 
Manager, try Process Hacker 
(from your free disc or http://
bit.ly/OoURT). To close a 
process, right-click it and 
select ‘Miscellaneous > 
Terminator > Run selected’. 
Take care – ending a system 
process could crash your PC.

37I can’t defragment 
my hard drive

Right-click a drive in Explorer 
and select ‘Properties > Tools 
> Defragment now’. If Explorer 
says no defragmentation tool 
is installed, launch REGEDIT, 
browse to HKEY_LOCAL_
MACHINE\SOFTWARE\
Microsoft\Windows\
CurrentVersion\Explorer\
MyComputer\DefragPath, 
double-click ‘Default’ and set 
it to %windir%\system32\
dfrgui.exe to repair it.

38Windows wants to 
burn files to disc

Your PC has temporary files 
that Windows thinks you’d like 
to burn to disc. If you’re sure 
you don’t, right-click your hard 

drive in Explorer and select 
‘Delete temporary files’.

40Some applications 
won’t play sounds

Click the system tray volume 
icon, click ‘Mixer’, and ensure 
any volume slider for your 
application is set high enough 
and not muted. Also launch 
Control Panel, click ‘Hardware 
and sound > Sound’, right-click 
your default playback device 
(it has a green tick) and select 

39My PC suddenly says 
Windows is not genuine

You bought Windows, activated it and everything was fine. 
Then, suddenly, a message appeared saying that your OS is 
not genuine, demanding you activate it – but activation 
doesn’t work. Launch REGEDIT, expand ‘HKEY_USERS’, 
right-click ‘S-1-5-20’ and select ‘Permissions’. Click ‘Network 
Service’ in the list. If you don’t see it, click ‘Add’, type Network 
Service and click ‘Check names > OK’ to add it. Make sure the 
‘Allow’ boxes for Full Control and Read are checked, then click 
‘OK’. Close REGEDIT, restart your PC and all should be well.

‘Properties’. Click ‘Advanced’ 
and clear any settings in the 
Exclusive Mode box. Click ‘OK’, 
reboot and try again.

41I need permission 
to access a folder

The folder probably belongs 
to another user on your PC. If 
you have an administrator’s 
account then Windows will say 
you can click ‘Continue’ to get 
access. If not, you must ask the 
other user for the files.

42 I accidentally 
deleted a file!

UndeleteMyFiles Pro 
(from your free disc or 
http://bit.ly/Zd3USw) is 
an excellent tool that 
makes it easy to recover 
apparently lost files, 
and even emails.

43My firewall  
isn’t working

Click ‘Start’, type 
firewall, select 
‘Windows Firewall’, then 
click ‘Restore defaults’ 
to return it to its 
original settings and 
get it working again.

44 My system is 
really unstable

Click ‘Control Panel > 
System and security > 
Action centre > 
Maintenance > Check 
for solutions’. Windows 
will check for problems 
and suggest fixes.

45 My libraries 
have vanished

Sometimes Explorer will 
forget its libraries, so if 
you click on the folder 
there’s nothing there. 
Right-click ‘Libraries’ 
and select ‘Restore 
default libraries’.

46My shortcuts 
are broken

ShortcutsMan (from 
your free disc) will scan 
your PC and tidy up 
shortcuts. It highlights 
any that are broken, 
and you can delete or 
fix them in moments.
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48Search can’t find 
my documents

Launch Control Panel, type 
Index and click ‘Indexing 
Options > Advanced > Rebuild 
> OK’ to create a new index.

49A program has 
stopped responding

Wait a moment – the program 
may be busy. If nothing 
happens you can close it from 
Task Manager (press [Ctrl]+ 
[Shift]+[Esc], right-click the 
program and select ‘End task’).

your computer’s memory 
problems’ to run a RAM test.

52A program is taking 
all of my CPU time

Launch RESMON.EXE and find 
the rogue process in the CPU 
box. Right-click it and select 
‘Suspend process’ to stop 
the program, then right-click 
and select ‘Resume process’ 
to start it again. Beware, this 
might crash the program and 
your system, so keep it as an 
absolute last resort. 

54I can’t create a 
System Restore point

To fix this, click ‘Start’, then 
right-click ‘Computer’ and 
select ‘Properties > System 
protection’. If protection is 
off for a drive, select it, click 
‘Configure’, choose the 
settings you need and click 
‘OK’. If protection is on already, 
or the change doesn’t help, 
run QuickSystemRestore (from 
your free disc or http://bit.ly/
VzkzU1). This will try to create 
a System Restore point and 
repair any problems.

55My desktop has 
stopped responding

Restarting Explorer may help. 
Launch Task Manager, click 
‘Processes’, right-click 
‘Explorer.exe’ and click ‘End 
process’. Now click ‘File > New 
task’, type explorer.exe and 
press [Enter]. A buggy shell 
extension might also be to 
blame. Use ShellExView (from 

50I see error messages 
when I install a program

Check that the application runs on your version of Windows.
Don’t launch a program directly from a web page; save it to 
your desktop first, then run it as an administrator. Uninstall 
older versions of the program (or at least close them down) 
before you install the new one. Left over temporary files can 
sometimes cause installation problems too, so use CCleaner 
(from your free disc) to clean them up, then try again.

47Bootmgr 
is missing

Boot from your Windows disc, 
choose a language option and 
click ‘Repair your computer’. 
Select your operating system, 
click ‘Startup repair’ and 
Windows will try to fix the 
problem. If that doesn’t help, 
boot to your System Recovery 
options, click ‘Command 
prompt’ (instead of ‘Startup 
repair’ as before) and enter 
the following commands:

bootrec /fixmbr
bootrec /fixboot
bootrec /rebuildbcd

Now close the command 
prompt, remove your Windows 
disc and try booting again.

your free disc or http://bit.
ly/3vpBOB) to find and remove 
any unnecessary extensions.

56A system component 
doesn’t work

Serious Windows problems 
could mean some system files 
are missing or corrupted. Click 
‘Start’, type cmd, right-click 
‘cmd.exe’ and click ‘Run as 
administrator’. Then type sfc /
scannow and press [Enter] to 
detect and repair any issues.

57 I’m still having 
problems!

There are lots more options 
you can try. For example, you 
can install any Windows 
updates, update your video 
card driver, remove plug-ins 
from applications or delete 
your temporary files. You can 
also right-click your drive in 
Explorer, then click ‘Properties 
> Tools > Check now’ to check 
it for errors.

51The screen turns blue 
and I have to reboot

Typically this means there’s 
a driver problem on your 
PC, although you may have 
hardware issues as well. Enter 
any error messages that are 
displayed on the screen into 
Google for guidance; update 
your drivers (DriverIdentifier, 
from your free disc or www.
driveridentifier.com, may be 
able to help); and launch 
Control Panel, search for 
memory and click ‘Diagnose 

53Why has a program 
locked up?

Launch RESMON.EXE, 
right-click the process and 
choose ‘Analyze process’ 
to see the threads in the 
process, and exactly what 
holds the resources that are 
making the program hang. 
You can then kill that part of 
the process if appropriate, but 
this is dangerous and may 
crash both the program and 
your PC. Only try this if it’s 
absolutely necessary. WATch And WAiT if a program isn’t responding, it might just be busy
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58A website doesn’t 
display properly

Websites built for old versions 
of Internet Explorer may not 
display properly in the latest 
versions. To try and fix this, 
click ‘Tools > Compatibility > 
View settings’, type the site’s 
domain name (www.google.
com, say) and click ‘Add’.

59I don’t want to share 
a particular folder

Browse to a folder you’d like to 
make private, right-click it and 
select ‘Share with’. Choose 
‘Nobody’ and other network 
users won’t be able to see it.

60How can I keep my 
kids safe online?

Run DNS Angel (from your 
free disc) and click ‘MetaCert 
DNS’. This makes your PC 
use MetaCert’s DNS servers, 
blocking most adult sites. 

61I can’t connect my 
PCs to one another

If your networked PCs can’t 
‘see’ each other, click ‘Start > 

Computer > Properties’ and 
look at the computer name, 
domain and workgroup 
settings. Each PC should have 
a different name, but the 
workgroup should be the 
same. If not, click ‘Change 
Settings > Change’. Enter and 
save your new details, reboot 
the PC and try again.

63I can’t reach  
some websites

If you can’t see one specific 
website, check www.down 
foreveryoneorjustme.com to 
see if it’s a general problem, or 
just you. If you find you can’t 
reach several antivirus vendors 
– www.avg.com and www.
avira.com, say – then that 
could mean you’ve been 
infected by a virus. Run a full 
system scan immediately.

64My PC connects to 
the wrong network

If you’re within range of two 
Wi-Fi networks then Windows 
may sometimes connect to 
the wrong one. To set it up 

correctly, click ‘Start’, type 
wireless and click ‘Manage 
wireless networks’. You’ll see a 
list of networks you’ve used. 
Use the ‘Move up’ and ‘Move 
down’ buttons to rearrange 
the list, with the most 
important at the top, and 
Windows should then connect 
to those networks first.

65How can I access my 
router settings page?

Download and run RCon.exe 
(www.nuetools.co.uk) and it 
will automatically open your 
browser at the right address. 
Alternatively, click ‘Start’, type 
nslookup.exe and press 
[Enter], then type the address 
it gives you into your web 
browser’s address bar.

66 I have no internet 
connection

If an internet program acts as 
though you’re not online, 
open a command window, 
type ping google.com and 
press [Enter]. If you see several 
‘Reply from’ messages then 
you know your internet 
connection is working.

If there are no replies, you 
should right-click the network 
icon in your system tray and 
select ‘Troubleshoot problems’ 
to launch the Windows 
Network Troubleshooter.

67Malware has messed 
up my IE settings

Install the Anvi Browser Repair 
Tool (from your free disc or 
http://bit.ly/S123Nh). It’s an 
excellent tool which can repair 
many broken IE settings in just 
a couple of clicks.

62A toolbar has taken  
over my web browser

Install some programs and they’ll try to equip your PC with 
a browser toolbar or some other annoying piece of spyware, 
which may take over your home page, search page and more. 
To remove this, go to ‘Control Panel > Programs > Uninstall a 
program’. Click the ‘Installed on’ header to sort your programs 
by date. If you see the toolbar, select it and click ‘Uninstall’.

If that doesn’t help, see if you can remove the extension 
manually. In Internet Explorer, click ‘Tools > Manage Add-ons’ 
to look for it (click ‘Tools > Add-ons’ if you’re using Firefox, or 
‘Tools > Extensions’ in Chrome).

If the toolbar is still there, run AdwCleaner (from your free 
disc or http://bit.ly/XJWrfY) to get rid of it.

68I suddenly lose my 
network connection

Launch Device Manager, 
expand ‘Network adaptors’, 
double-click your network 
adapter and select ‘Properties’. 
Click ‘System idle power saver’ 
in the list. If this is turned on, 
set its value to ‘Disabled’, 
reboot and try again. If that 
doesn’t help, return to the 
Properties dialog and click 
‘Power management’. Turning 
off the power saving options 
might help, but bear in mind 
that it may also shorten the 
battery life of laptops.

69I want to deactivate 
IE’s spell checker

Internet Explorer 10 will 
regularly highlight words it 
thinks are misspelled. If you 
don’t need this, click ‘Tools > 
Manage add-ons > Spelling 
correction’ and clear the 
‘Enable spelling correction’ 
box to turn it off.

70A device isn’t 
working properly

Run Devmgmt.msc to launch 
Device Manager. If Windows 
finds a problem, it highlights 
the device with a yellow icon. 
Double-click this for details, or 
click ‘Driver > Update driver’ 
to try to fix things.
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72My DVD drive  
isn’t recognised

Run REGEDIT, browse to 
HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControlSet\
Control\Class\{4D36E965-E325-
11CE-BFC1-08002BE10318}, 
delete both UpperFilters and 
LowerFilters and reboot.
If that’s no help, click ‘Start’, 
type disk management and 
click ‘Create and format hard 
disk partitions’. Right-click your 
optical drive, select ‘Change 
drive letter and paths’, click 
‘Change’, choose a new letter 
and reboot. If the drive is now 
visible in Explorer, you can 
repeat the process to change 
the drive letter back.

73I can’t find certain 
device settings

If you can’t find the hardware 
settings you need in Control 
Panel, open the Devices and 
Printers folder, instead. It will 
have icons for many of your 
devices, and just right-clicking 
any of these will list your 
available options.

74 I accidentally hit my 
laptop’s touchpad

Install Touchpad Blocker 
(which you can get from your 
free disc, or download from 
http://touchpad-blocker.com) 
or Touchfreeze (from your 

disc or http://bit.ly/5rvRbH). 
These programs disable the 
touchpad when you’re typing, 
so if you accidentally brush it, 
nothing will happen.

75 I’m having problems 
with a USB device

If your PC doesn’t recognise a 
USB device – or it just doesn’t 
work properly – then try 
plugging it into a different 
USB port. There may be a USB 
connector on your monitor or 
your keyboard, but you’ll often 
get better results with a USB 
port on your PC.

76My PC’s disk drives 
are too slow

Launch Device Manager, 
Expand ‘Disk drives’, double-
click the drive you’d like to 
speed up and click ‘Policies’. 
Checking both ‘Enable write 
caching’ and ‘Turn off 
Windows write-cache buffer 
flushing’ should improve your 
drives’ performance, but take 
care – if your PC’s power fails 
then you’re much more likely 
to lose data than if you leave 
these settings alone.

77How can I rename 
a USB flash drive?

Renaming your USB keys can 
make it easier to tell them 
apart, but the usual route 

(right-click, then select 
‘Rename’) doesn’t always work 
as it should. If this happens to 
you, make sure there’s nothing 
you need on the USB drive, 
then reformat it (right-click, 
then select ‘Format’) and try 
renaming it again.

78My monitor’s colours 
are inaccurate

This is a very common 
problem. First, try adjusting 
your monitor’s physical 
controls (white balance, 
brightness, contrast and so 
on). If that’s no help, click 
‘Start’, type DCCW.EXE and 
press [Enter] to launch the 
Display Colour Calibration 
Wizard, which should help 
you improve the situation.

71I need 
more hard 

drive space
There are many ways to free up 
valuable hard drive space. Start 
by using WinDirStat (www.
windirstat.info) to find the 
largest files and folders and 
uninstall programs you don’t 
need. Run Disk Cleanup or 
CCleaner (on your free disc) to 
find and remove junk files. 
Launch Explorer, right-click the 
drive and select ‘Properties > 
Tools > Check now’. This will 
check your drive for errors, and 
may recover lost space. If you 
don’t use hibernation, disable it 
(run cmd.exe as an administrator 
and enter powercfg -h off) to 
save drive space.

79I can’t always see the 
cursor on my laptop

Click ‘Start’, type pointer, 
click ‘Make it easier to see the 
mouse pointer’ and check 
‘Disable pointer trails’ to 
make the cursor more visible. 
Alternatively, check ‘Show 
location of pointer when I 
press the [Ctrl] key’ and click 
‘Apply’. Now, when you press 
[Ctrl], Windows will highlight 
the mouse cursor for you.

80My laptop’s battery 
life is too short

Click ‘Start’, type cmd, 
right-click CMD.EXE and select 
‘Run as administrator’. Type 
powercfg -energy, press 
[Enter], and check the report 
it produces for problems.
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81The wrong keyboard 
characters appear

If you press some keys on your 
keyboard and the wrong 
characters appear, click ‘Start’, 
type region and click ‘Region 
and language > Keyboards 
and languages > Change 
keyboards’. If you don’t see 
‘English (United Kingdom)’ in 
the Installed Services box, click 
‘Add’ and select it. Now click it 
in the list, then keep clicking 
‘Move up’ until it’s at the top. 
If there’s a language in the list 
that you don’t need, choose it 
and click ‘Remove’.

82Video quality on  
my PC is poor

Click ‘Start’, type power 
options and click the ‘Power 
Options’ link. Click ‘Change 
plan settings’ for your current 
plan, click ‘Change advanced 
power settings’, expand 
‘Multimedia settings’ and 
make sure Playing Video is set 
to ‘Optimise video quality’.

83Text doesn’t look 
clear enough.

Launch cttune (the ClearType 
text tuning wizard) and follow 
the instructions provided.

85The keyboard isn’t 
working properly

In an emergency, you can 
always click ‘Start > All 
Programs > Accessories > 
Ease of access’ and launch 
the on-screen keyboard. Then 
simply select the program 
you’re trying to control, return 
to the on-screen keyboard and 
click its keys as necessary with 
your mouse.

86Can I run a program 
as another user?

Yes, if you have the right 
login credentials. Just hold 
down [Shift], right-click the 
program’s shortcut and 
choose ‘Run as different user’. 
Enter the username and 
password for that account and 
your application will launch.

87What photo-editing 
program is best?

If you’re in a hurry and your 
needs are simple, give 
Windows Paint a try – it’s 
better than most people 
realise. You can crop images, 
resize or rotate them, paint 
and draw, and even add 
some fun annotations such 
as thought bubbles.

88My PC is infected 
with a virus

Before you try downloading 
a security tool, click ‘Start’, 
type MRT and press [Enter]. 
If it’s installed you’ll see the 
Microsoft Windows Malicious 
Software Removal Tool, which 
may be able to help remove 
the virus from your PC.

89How can I step 
through a video?

It’s not exactly obvious, but 
pressing [Ctrl] while clicking 
the ‘Play’ button in Windows 
Media Player will step forward, 
while pressing [Ctrl]+[Shift] will 
clicking ‘Play’ will step back.

90I can’t install a new 
program on my PC

Close all other programs 
before you run the installer. 
Uninstall the old version, 
if there is one, and use the 
Disk Cleanup tool to clear 
temporary files. If all else fails, 
create a new user account and 
install it from there.

91I need more screen 
grab options

Windows can capture the 
entire screen to the clipboard 
if you press [Print Screen], 
or just the current window if 
you press [Alt]+[Print Screen]. 
If you want more, though, 
launch SnippingTool.exe. It can 
also grab rectangular or even 
freehand areas from any part 
of the screen you like.

92Drag and drop isn’t 
working properly

If you’re running one program 
as an administrator and 

84It takes too long to set  
up a new computer

When a new PC arrives, you’ll probably want to equip it with 
browsers, Flash, a PDF viewer, a zip manager, a media player 
and lots more. Normally you’d find these by browsing directly 
to each program site and looking for the download page. 
DDownloads (www.ddownloads.net), however, knows all 
about 900+ popular applications. Just choose a program, 
click ‘Direct download from page’ and it’ll open a browser 
window and begin downloading the file you need. And it can 
do much more. Right-click an application for extra options.

another just normally, then 
you’ll probably find you can’t 
drag and drop files between 
them. Run both with the same 
rights, and drag and drop 
should work.

93Can I stop my kids 
installing software?

If you want to prevent other 
users of your system from 
installing programs, give 
Installguard a try (get it from 
your free disc or download it 
from www.completelock.com). 
Free for personal use, it 
ensures only authorised users 
can install software, and only 
programs you permit are 
allowed to run on the system.

94What tool do I need 
to open this file?

If you sometimes download a 
file and then don’t know how 
to open it, install OpenWith 
Enhanced (from your free disc 
or http://extensions.frieger.

com/owdesc.php), right-click 
any file, select ‘Open with’, and 
the program will recommend 
applications that can open it.

95I lose data when I 
reboot my PC

Launch REGEDIT, browse to 
HKEY_LOCAL_MACHINE\

softWarE

picTure perfecT for simple photo editing, don’t underestimate paint
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Software\Policies\Microsoft\
Windows\System, and look 
for the DWORD value Allow 
Blocking AppsAtShutdown. 
If you see this, and it’s set to 
zero, double-click it, set the 
value to one and click ‘OK’.

96Can I run a program 
as an administrator?

Yes, and it isn’t difficult. 
If you can see the program 
executable (or a shortcut), 
right-click it and select ‘Run as 
administrator’. If you’re using 
the Run box, though, type the 
program name – REGEDIT, for 
example – then hold down 
[Ctrl] and press [Enter] to 
launch the program with 
administrative rights.

97Do I have 32- or 
64-bit Windows?

Some programs come in both 
32- and 64-bit flavours, so it’s 
useful to know which version 
of Windows you have. To find 
out, click ‘Start’, right-click 
‘Computer’, select ‘Properties’, 
and the System Type entry will 
tell you whether you have a 
32- or 64-bit operating system.

98 I’ve lost a Windows 
product key

Reinstalling Windows is 
generally very easy, but you 
will need your Windows 
product key. It’s usually on 
a sticker that’s attached to 
your PC or Windows disc box, 
but if you can’t see anything 
then Keyfinder (from this 
month’s free disc or www.

magicaljellybean.com) will 
help you recover it.
 

99A program is 
hogging my CPU

If an application has a high 
CPU usage but you don’t want 
to close it, press [Ctrl]+[Shift]+ 
[Esc], click ‘Processes’, right-
click the process and select 
‘Set affinity’. Now clear ‘All 
processes’, select just one 
CPU core and click ‘OK’. The 
program is now unable to use 
your other cores, leaving them 
free for other applications.

101Files are opening in  
the wrong program

If double-clicking a file on your desktop doesn’t open it in 
the right application, don’t worry – this is easy to fix. First, 
launch Control Panel and click ‘Programs > Default programs 
> Set your default programs’. Now choose the application 
you’d like to open this file in the Programs list and click 
‘Choose defaults for this program’. Check the file types you’d 
like this application to handle by default (or check the ‘Select 
all’ box if you’d like to use it for everything). Clear the others 
and click ‘Save’ when you’re done. Your files should now open 
in the application of your choice. ■

100I can’t 
uninstall  

a program
Go to ‘Control Panel > Programs 
> Uninstall a program’, click it 
in the list and select ‘Uninstall’. 
If you don’t see the program 
there, click ‘Start > All programs’, 
select its folder and look for an 
‘Uninstall’ option. If you find 
the uninstaller but it seems to 
hang, be patient; removing an 
application can take a while. 
If the program doesn’t work 
first time, reboot and try again, 
or try uninstalling the program 
from Safe Mode. Sometimes 
reinstalling an application will 
allow you to uninstall it. If all else 
fails, Revo Uninstaller (www.
revouninstaller.com) can remove 
many stubborn programs.

Graham’s verdict
Windows problems can seem extremely complex, but as we’ve 
seen, that’s often not the case. Just tweaking a single setting or 
running the appropriate applet may be all it takes to get your 
system working again. When life isn’t so straightforward though, 
you’ll need to apply a few more general strategies.

If you’re experiencing a new technical issue with Windows for 
instance, you could try using System Restore to recover your 
previous settings and system files. Some programs may need to 
be reinstalled afterwards but your data files won’t be affected.

Microsoft’s Fix it Centre (http://support.microsoft.com/fixit) 
has a host of automated solutions to all kinds of problems. 

Check out the general Microsoft support site, too 
(http://support.microsoft.com). There are helpful 
text documents, tools to download, forums to get 
help from other users, and you can even chat live 
with Microsoft technicians.

Graham Barlow Editor-in-Chief
www.facebook.com/windowsmag
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Learn how to…
Fix problems 
with photos

“Discover how to improve 
imperfect photos with the help of 
the latest version of Paint.NET.”

or years, Paint.NET has 
enjoyed a well deserved 
reputation as one of the 

best free image editors for your PC, 
and it’s back with a bang with the 
recently released version 4.0. It’s able 
to take full advantage of your PC’s 
power – its multi-core processor 
and all of its memory – to deliver 
better, more responsive editing tools, 
accompanied by a smattering of 
new features and redesigned user 
interface. For those still running XP 
or Vista, you can still download the 
previous version from the www.
getpaint.net website.

In this tutorial I’ll run through 
some of the ways in which you can 
use its adjustment tools and filters 
to improve less than perfect photos. 
You’ll also discover how to expand 
Paint.NET’s features with the help 
of third-party plugins, so without 
further ado, let’s breathe new life 
into apparently ruined snapshots…

1 First steps
You’ll find the latest version of Paint.NET on the cover disc, 

so install it from there. Remember, it requires Windows 7 or 8. 
If necessary, the setup program will download and install the 
necessary .NET Framework 4.5 package. Once installed, launch 
the program. To make changes to an existing image on your hard 
drive, open the File menu and select ‘Open’ to locate and select it.

2 Import photo
Alternatively, choose ‘File > Acquire > From scanner or 

camera’ to scan or transfer a photo. If scanning a photo, click 
the ‘Preview’ button first, then use the drag handles to frame it 
correctly if necessary. Click ‘Adjust the quality of the scanned 
picture’ for more options – we think the default 200dpi setting is 
a little low, so consider pushing it up to 300dpi. Click ‘OK > Scan’.

Step-by-step Correct photos using Paint.NET

Your guide Nick Peers says…

Tool opTionS
Here you can see the available 
options for the currently 
selected tool. Switch tools 
using the palette below. 

Colour paleTTe
Here’s where you 
can set Paint.NET’s 
primary and 
secondary colours. 
Click the ‘More >>’ 
button to access 
additional options. 

F
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

at a glance…
SKill leVel

Time TaKen

SuiTable For

30 minutes
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3 Correct lighting issues
Once scanned or imported, save a copy of your image. If it 

appears too dark or washed out, select ‘Adjustments > Levels’ to 
see a pair of histograms. Click ‘Auto’ for a quick fix, then fine-tune 
the black and white input levels using the sliders on the left to 
select the range of colours to include. Finally, tweak the white, 
grey and black points on the right to get the best result. Click ‘OK’.

4 Fine-tune colour
You can use the Levels Adjustment tool to tweak the colour 

balance too: untick the G and B boxes to adjust the red colour, 
or tick just G to adjust green, or B to adjust blue. You can also tick 
two boxes to adjust yellow (R and G), purple (R and B), and aqua 
(G and B). Once you’ve selected a colour, experiment with its 
input and output levels to see how it affects your image.

Jargon buster!
 Dll

A kind of file that 
adds functionality 
to the program it’s 
associated with, such 
as extra effects in 
Paint.NET.

 Histogram
A tool that is used 
to display the 
distribution and 
density of an image’s 
individual colours as 
well as its overall mix 
of dark, light and 
mid-range tones.

 layer
These are used to 
split different parts 
of an image into 
individual elements, 
each of which can be 
edited separately.

SwiTCH imageS
All open images are displayed 
as thumbnails at the top of the 
program window – click one to 
select it for editing. 

Tool buTTonS
Click these to show or hide the 
main floating tools, change 
Paint.NET’s key settings, and 
access the Help menu. 

HiSTory winDow
This makes it easy to 
review your changes 
step-by-step, and 
undo (or reapply) 
several edits with 
just one click. 

layerS
Manage multi-layered images from 
this window. Click the button in the 
bottom-right of the window to access 
Layer Properties. 

Nick’s best tiP!
Make sure you’re happy with 
your editing before clicking 
‘save’ – once done, you won’t 
be able to undo any changes.

Explore 
Fix problems with photos
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9 Install plugins
Once downloaded, double-click the zip file to open it and 

you should find one or more DLL files. Now open a separate 
folder window and browse to C:\Program Files\paint.net\Effects. 
Copy the DLL files into this directory, ticking ‘Do this for all current 
items’ and clicking ‘Continue’ if prompted for administrator access. 
Once complete, restart Paint.NET to access your new plugins.

7 Apply more fixes
Select ‘Effects > Photo’, where you’ll find five options. 

Both Sharpen and Red Eye Removal are corrective adjustments. 
Sharpen can be used to mitigate the effects of blurring. To remove 
red eye effects, select the elliptical tool and draw a rough circle 
around the first eye. Now hold [Ctrl] and repeat over the second 
eye. Finally, choose ‘Effects > Photo > Red Eye Removal’.

5  Reduce noise
Paint.NET has a number of tools for cleaning up noise, dust 

and scratches. Start by using the Zoom slider (at the bottom right) 
together with the Hand tool to get a closer look at a particularly 
speckled part of the image. Select ‘Effects > Reduce noise’, then 
use the Radius and Strength sliders to reduce the effect of the 
noise without wiping out too much detail. Click ‘OK’ when done.

10 Access plugins
New plugins should appear in the Adjustments or Effects 

menu with a jigsaw icon indicating that they’re third-party 
add-ons. Select one to access its features. Check out this month’s 
Support Squad if your security software blocks any plugins, and 
remove any troublesome or unwanted ones by deleting the DLL 
file from the C:\Program Files\paint.net\Effects directory. ■

8  Get new tools
You can expand Paint.NET’s range of adjustment tools and 

filters with a free third-party plugin. Click the ‘Help’ button and 
choose ‘Plugins’ to visit the Paint.NET forum. Click on a plugin 
to learn more about it, or try a collection such as BoltBait’s 
Plugin Pack for v4.0. When you’ve found one you like, click the 
‘Download’ link to save a zip file to your Downloads folder.

6 Remove larger blemishes
Scratches and larger speckles can be dealt with using the 

Clone Stamp tool. With the tool selected, set the brush width to 
just slightly larger than your first blemish. Now choose a similar – 
but clean – part of the image, hold [Ctrl] and click to select it. 
Place the brush over the blemish and click it once or twice to 
cover it up. Repeat for all the blemishes in your image.
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Learn how to…
Send files to friends 
and family using Skype

“You might already know how to use Skype to make 
free calls from your PC, but it has a few more clever 
tricks up its sleeve, too.”

ou’re probably familiar 
with using Skype for 
making free phone calls 

and sending instant messages, 
but there’s a lot more you can do 
with this surprisingly powerful 
communication program. For 
example, you can use it to send files 
directly to another person while 
chatting via text or voice. These 
files could be anything from photos 
of your kids to spreadsheets or 
business presentations. Sending 
files via Skype is much more 
convenient than opening a web 
browser to send an email while 
you’re talking, and it won’t interrupt 
the flow of the conversation

In this walkthrough I’m going to 
show you how to send files in two 
different situations – as an instant 
message and in the middle of a 
voice chat. Sending files during 
a video chat works in exactly the 
same way as a voice call.

1 Register and sign in
If you’re using Windows 8.1, download the Skype app from 

the Microsoft Store then sign in using your Microsoft account. 
If you’re using Windows 7, Vista or XP, visit www.skype.com/en/
download-skype and click ‘Get Skype for Windows Desktop’. Once 
the program is installed you can create a new account, or sign in 
using your Facebook or Microsoft account.

2 Find a contact
First, we’ll show you how to send a file to somebody using 

Skype’s instant messaging system. Start by finding the person in 
your Contacts list and clicking their name. This brings up their 
details as well as the last instant messaging conversation you had 
with them. If the person isn’t already in your Contacts list, you can 
add them via Facebook – see http://bit.ly/YLp55O.

Your guide Sue Huntley says…

Y

Sue’S beSt tip
You can send multiple files 
at once by holding [Ctrl] and 
clicking each one in turn 
before clicking ‘Open’.

Step-by-step Do more with Skype

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

20 minutes
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7 Send and receive
The other person will notice a red dot over the speech 

bubble icon at the bottom left, which indicates that they have 
received a file as an instant message. Once they click the speech 
bubble icon, a window will slide up revealing the details of the 
file. It isn’t downloaded automatically; they must click ‘Save as’ to 
retrieve it and store it on their own hard drive.

8 Access saved files
If you’ve misplaced a file that you were sent via Skype, it’s 

easy to find and recover it. Simply click on the name of the sender, 
scroll through your last instant message conversation until you 
find it, then click the ‘Open file’ button to retrieve it. Alternatively, 
you can click the ‘Show in folder’ link to reveal the file in a new 
Explorer window. Who needs email attachments? ■

5 Start a conversation
As well as sending a file to an existing contact, without 

calling them, you can also send a file during a voice or video call. 
Start the call in the normal way by clicking the ‘Make phone call’ 
button. Once the call has been accepted, the Skype screen 
changes to look like the one pictured here. You can now start to 
talk and your contact will be able to hear what you’re saying.

3 Find the file
Click the plus icon (between ‘Call phone’ and the signal 

strength indicator) and choose ‘Send file’ from the menu that 
appears. Locate the file on your PC’s hard drive and click ‘Open’, 
just as you would if you were attaching a file to an email. As the 
menu here shows, you can also share contacts, send a video 
message or share your screen this person.

6 Choose a file
The plus button looks a little different, but the procedure is 

pretty much the same as before. Click the button during the call, 
choose ‘Send file’ from the menu that appears, browse to the file, 
select it and click ‘Open’ . You won’t be informed that the file is 
waiting to be sent, as you were in the previous steps, but don’t 
worry – the recipient will receive an alert.

4 Send the file
When you click ‘Open’, the recipient will see a message in 

the chat session specifying the name and type of the file you’ve 
just sent, and will be given the option to either accept or decline 
it. Once they accept, the file is delivered. You’ll know it’s been 
received successfully at the other end when you see its status 
change from ‘Waiting’ to ‘File sent’.

Explore 
Send files using Skype
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Learn how to…

“If you’re in search of a leaner, cleaner and ultimately 
faster machine, follow these handy tips for keeping 
Windows 7 working at peak performance.”

hen it launched Windows 7, Microsoft 
prided itself on having made the new 
operating system far less bloated than 

Windows Vista and XP. This meant it ran better 
than those earlier versions, but there’s still lots 
of room for improvement. Whether you think 
it’s time you reinstalled your operating system 
for improved performance, or you want to help 
speed it up after a reinstall, we’ll guide you 
through a variety of methods that will ensure 
you you’re using a lean, fast version of 
Windows 7 for as long as possible.

We’ll start with making a 
slimmed down installation 
for those who want to take 
the plunge and reinstall 
everything on their PC. This 
will ensure that from the start 
you get a smaller footprint than 
you would if you simply got out your 
original Windows 7 installation disc and 
reinstalled from there. We’ll then move on 
to some more general decluttering tips that 
will help keep your trimmed Windows 7 install in 
check. Let’s get cracking…

1 Trim your reinstall
There are many tools that can help create a slimmer 

Windows install for you, but we’re going to use RT Seven Lite 
(www.techradar.com/downloads/rt-se7en-lite). Download and 
run it. Choose ‘Express’ as the install option, then click ‘Next’ on 
each following screen to complete the process. Now it’s time to 
grab that Windows installation disc.

2 Create temporary folder
You’ll now be presented with the RT Seven Lite interface. 

You will need to extract your Windows 7 disc files somewhere in 
order to use the program to edit them, so before you create your 
slim install, make a temporary folder on your desktop called Win7 
Lite (or similar). Don’t worry about making extra clutter – you’ll be 
able to delete this folder when you’ve finished.

Your guide Christian Hall says…

W

Step-by-step Declutter your Windows 7 installation

Slim down Windows 7 
for faster performance

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

2 hours

CHristian’s best tip
to include wallpapers, themes 
and more with your Rt 
seven Lite installation, add 
them under ‘Customization’.
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7 Remove features
This is a very important section, which lets you remove 

applications and other features from Windows to make it more 
lightweight. The left box lets you check boxes to permanently 
remove apps, while the right box lets you uncheck boxes to 
merely disable certain features. If you’re not sure what a program 
or feature does, a description is given for each.

5 Tweak the install
When the process is complete, you can begin 

tweaking. Click the ‘Task’ button in the left sidebar. 
From here, you can choose which portions of 
Windows you want to customise. You have six 
checkboxes on this page, which correspond to the 
six sections on the left sidebar of the app.

3 Create an ISO
Click the ‘Browse’ button on the main page 

and find your Windows 7 ISO. If you have a physical 
Windows 7 disc, you’ll need to create an ISO using 
ISO Recorder (http://bit.ly/1qIb4kO). Install it, then 
right-click your DVD drive and choose ‘Create image 
from CD/DVD’, pick a path and click ‘Next’.

8 Final tweaks
Click on the ‘Tweaks’ tab to make further changes. There are 

10 different categories to choose from here. The worst offenders 
in terms of ‘bloat’ are under the heading Services. Before you burn 
the disc, visit the ‘Un-attended’ tab, where you can enter your 
product key so it activates automatically after you install 
Windows, saving you time and hassle.

6 Integration
Only the options 

selected will be highlighted 
in the left sidebar. The first 
(if you’ve chosen it) is 
‘Integration’. If there are 
certain updates that you 
really need in the original 
installation, you can choose 
them here. ‘Updates’ is 
the most important, so 
go to the appropriate tab, 
choose ‘Add’ and then 
navigate to C:\Windows\
SoftwareDistribution\
Download to select it.

4 Slipstream the Service Pack
Back in RT Seven Lite, select your temporary 

folder as the extract path and click ‘OK’. When it 
asks which image to configure, choose the correct 
Windows version. If you want to slipstream Service 
Pack 1 into your disc, check the ‘Slipstream Service 
Pack’ box at this step – it can’t be done later.

Jargon buster!
 ISo

ISO files are archive 
files on a disc, which 
are bootable. You 
can copy ISOs to USB 
sticks to boot from 
as well.

 Slipstreaming
This term refers to 
packaging up a 
services of updates 
in a Windows Service 
Pack together into 
one disc image (see 
ISO, above).

 Hibernation
This saves your 
current system state 
to a file on your 
hard drive before 
powering off so it 
starts more quickly 
next time.

Explore 
Slim down Windows 7
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13 Switch off System Restore
Another way to save space is to turn off System Restore 

completely. Open the Start menu, right-click and choose 
‘Properties > System Protection’. In the new window that appears, 
click ‘Configure’ and in the next Window select ‘Turn off system 
protection’ and then click ‘OK’ followed by ‘Apply’. You can go back 
here to re-enable it if you change your mind.

11 Start menu items
Once you’ve installed your new, slim version of Windows, 

you can make some post-install adjustments. Speeding up boot 
processes is a classic. To do this, open System Configuration (type 
msconfig in the Start Menu’s search box and press [Enter]) and go 
to the ‘Startup’ tab. Simply uncheck any items you don’t want and 
click ‘Apply’ when you’ve finished.

9  Prepare to burn
When you’re done, go to the Log section and click ‘Commit’. 

This will make all your changes in the temporary folder you 
created on the desktop. The process could take up to an hour 
or more, depending on how much you’ve tweaked. You can also 
click ‘Export settings’ before ‘Commit’, which will save the tweaks 
in case you want to come back and edit them later.

14 Slim the Windows 7 partition
You’re almost finished, but there’s one more simple trick 

you can try. You can move some Windows system files to a new 
partition without reinstalling. Go to ‘Control Panel > System > 
Advanced system settings’ and click ‘Environmental Variables’. 
Now just point the value of the variables TEMP and TMP to 
another partition on your PC and hit ‘OK’. ■

12  Disable hibernation
If you have a Windows 7 laptop and don’t tend to use 

its hibernation feature, you can type powercfg -h off into the 
command prompt (type cmd in the Search box and hit [Enter]). 
Doing this will disable hibernation and delete the hiberfil.sys file, 
which can be a few gigabytes in size depending on the amount 
of RAM installed in your system.

10 Choose install version
Now you’re ready to head to the ISO-Bootable section and 

create your custom installation disc (or USB stick, if you prefer). 
Under Mode, you can choose ‘Direct burn (DVD)’, ‘Create image 
(ISO file)’ or ‘USB bootable’. Give the volume a name, then hit 
‘Finish’. You can split the install across discs or USB sticks if it’s too 
large for the one you have.
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Learn how to…
Improve ‘snapping’ 
Windows

“Go beyond the side-by-side ‘snapping’ in Windows 
with WinDock – a tool that lets snap more than two 
windows and arrange them to your liking.”

hen Windows 7 introduced the 
Aero Snap feature, allowing you 
to see two windows side-by-

side simply by dragging one to the left 
of the screen and another to the right, 
we all wondered how we ever managed 
to live without it. However, this incredibly 
useful feature has never really been 
expanded upon – until now!

The free WinDock application has 
been developed with larger screen sizes 
and multiple monitor setups in mind. 
Finally, you can define not just a left and 
right ‘snap’, but also top and bottom, 
screen corners and even pre-defined 
hotspots on your screen. Now three, four, 
or even more windows can be snapped 
together with new actions. WinDock 
can remember a number of 
different configurations for 
future use too, which makes 
it really easy to quickly place 
program windows where you  
want and across multiple screens  
if you have them.

1 Add a profile
Download and install WinDock from www.ivanyu.ca/

windock. When you open the program you’ll see two default 
options; the ‘ – Active’ suffix tells you which one is currently in 
use. To make your own profile, click ‘Add’ and then give it a name. 
We’ve chosen ‘Triptych’ (three-piece work of art) to describe a 
setup of three portrait windows snapped together.

2 Set a rule
Now you need to define what your snapped windows 

look like and how they are to be ‘snapped’. Under the Rules area, 
choose ‘Add’. A new window pops up showing you how to define 
the areas on-screen. We’re starting with one monitor, so leave it 
set to 1. Now pick ‘Edge’ under the Trigger Type and then select 
which edge you want to define.

Your guide Christian Hall says…

W

CHristian’s best tip
to save your dock positions, 
tick ‘start with Windows’, 
then click ‘Apply’, under the 
General section of settings.

Step-by-step Arrange and snap Windows

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

10 minutes
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7 Multiple monitors
WinDock is ideal for multiple monitor setups too, enabling 

you to snap windows to an entirely different screen rather than 
just a portion of your default screen. To get started, add a new 
profile or rule choose Monitor 2 and select a Trigger Type as 
before. You can now define what ever area you want, but make 
sure ‘Monitor 2’ is selected in the Dock Position area.

8 Get snapping
That’s it! Finally, you can make better use of your snapped 

windows. WinDock supports up to four monitors too, meaning 
you could use the corner areas of your first monitor to snap a 
window to a different monitor! Whatever configuration you 
choose, remember that you can change it easily at any time by 
editing the rules in the WinDock settings. ■

5 Area triggers
Assign a new profile and add a new rule, but this time 

choose ‘Area’ as the Trigger Type. We’re going to make the centre 
of the screen the area we want to snap. This would make our 
Trigger parameters something like ‘Left 30%’, ‘Top 30%’, ‘Right 
70%’ and ‘Bottom 70%’. Your Dock Position parameters could be 
anything you like; we’ve chosen the top-left corner.

3 Understand the measurements
Dock Position is the screen area allocated to each window, 

and it can be a little difficult to grasp. Essentially, you need to 
think about a start and end point for each window – the furthest 
left and uppermost being 0% in each of the Left and Top columns 
respectively. Our first window would be ‘Left 0%’ and ‘Right 25%’, 
making it fill the screen height in a thin column to the left.

6 Corner triggers
WinDock also enables you to snap a program window into 

position by dragging your mouse cursor to a corner of the screen 
(much like you do when bringing up the Charms in Windows 8). 
To do this, start by creating a new profile and adding a rule. Now 
choose ‘Corner’ as the Trigger Type and then choose a corner that 
will trigger the snapped window.

4 Add more rules
Click ‘OK’ to confirm the first rule, then choose ‘Add’ again. 

To create a window of the same size, but this time positioned on 
the right-hand side of the screen choose ‘Right’ as the Edge and 
then under Dock Position choose ‘Left 75%’ and ‘Right 100%’. 
These leaves us with a 50% gap for our last window in the middle. 
That would be ‘Left 25%’ and ‘Right 75%’.

Explore 
Improve ‘snapping’ windows
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Learn how to…
Make your 
own PC games

“Kodu Game Lab is a brilliant way 
to introduce kids to programming 
by making their own games.”

re your kids always glued to 
the PC? Do they dream of 
making their own computer 

games? You can make those dreams 
come true with the Kodu game 
creation system! Kodu was designed 
to help teachers who don’t know 
how to program explain the basics of 
programming languages. As such, 
it’s a great way to get your kids 
interested in coding. 

That might sound very daunting 
but Kodu is incredibly clever. It 
transforms the somewhat baffling 
business of programming a computer 
into a visual process that you control 
with a mouse. All you need do is drag 
and drop, point and click, but there 
are valuable lessons to be learned in 
logic and how computer programs 
work. What makes Kodu even more 
impressive is the fact that it’s free. 

So what are you waiting for? Stop 
just playing computer games and 
start making your own.

1 Download and install
First, head to www.kodugamelab.com, click ‘Get Kodu’ and 

then select ‘Download’. At the bottom of the screen you’ll see 
a ‘Run’ option. Click this and Kodu will install once it’s finished 
downloading. When it’s finished, accept the licence agreement 
and click ‘Install’. When the program begins you’ll see an 
introductory video, which is well worth watching.

2 Hello Kodu
Kodu, in case you’re wondering, is the aerial-wearing, 

bug-eyed little chap you’ll see when the program starts running. 
He (or possibly she) is the character you can control in the games 
you play. What these games are and the shape they take is 
entirely down to you. To see how the process works, click ‘Load 
world’. This will bring up pre-built games and worlds. 

Your guide Martin Cooper says…

A

Step-by-step Build your own computer game

DougHnut menu
Kodu’s menu 
system is easy to 
use, being based 
around a circular 
wheel of icons. 
These icons 
denote functions 
and features. As 
you click, new 
menus appear.

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEn

SuITAbLE for

15 minutes
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3 open a world
In this screen you’ll be able to scroll through all the 

pre-made games and worlds that Kodu arrives with. Use either 
the big green arrows or your mouse’s scroll wheel to move 
through the list. To begin our Kodu experiment we’re going to 
load up Shooting Fish, so scroll along until you find it. When you’re 
there, press [Enter] and the game will load. 

4 Bland fish
What you should see is a flat world with some fish 

swimming around. They’re pretty enough, but this doesn’t make 
for much of a game. Let’s be honest – you can’t shoot them, and 
that’s no fun! What we want to do is add a character that you can 
control, and build in some action too. The first thing you need to 
do is press [Escape] to end the game.

Jargon buster!
 Programming 

languages
Artificial languages 
that are used to 
give instructions to 
a machine. Most 
languages are made 
up of a series of 
commands that tell 
the computer what 
to do, and when.

 Coding
Writing instructions 
for a computer using 
a programming 
language (above).

 Version number
When you download 
a program you’ll 
often see it has v1, 
v2 or maybe v3.1 
after its name. 
These are version 
numbers. Each time 
a programmer works 
on a program and 
makes some changes 
they’ll change the 
program’s version 
number. Big changes 
are denoted by a 
new full number. 
Small changes get 
just a decimal point.

ACtions
The bump function is useful. 
You can use it to tell objects 
how to behave if they touch 
each other. They may explode, 
run away or freeze. The choice 
is entirely yours.

KeyBoArD Controls 
This icon will begin assigning 
keyboard controls to Kodu. 
Click it and it will bring up a 
menu of specific keys that you 
can pick from. 

lines of CoDe 
As you work your way 
though the different 
menus you’ll notice 
that your lines of code 
will extend, showing 
the instructions you’ve 
given to certain 
characters and objects. 

Explore 
Make your own PC games
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9 trial and error
The key with Kodu is to keep testing your game. If 

something doesn’t behave the way you expect it to, you’ve made 
an error. Don’t worry, problems are easily remedied, and even the 
best programmers make mistakes occasionally. If you spot an 
error in your code, just right-click on it and select ‘Cut tile’. You can 
then add the correct instruction and nobody will ever know.

7 Controlling Kodu
Click the ‘+’ next to ‘Keyboard’ in your line of code, then 

select ‘Arrows’. Now click ‘Do’. This brings up the actions menu. 
When you’re here, click the ‘Move’ icon. In effect we’ve written 
a series of instructions that will move Kodu when an arrow is 
pressed. To test your program press [Escape] and then the green 
triangle on the main menu. 

5 the important menu
You’re now in the Kodu game editor, where all the action 

takes place. Let’s start by adding our hero Kodu to the game.  
Click on Kodu to bring up the ‘Object tools: add or edit characters 
and objects’ menu. Now click on the game-playing area. This will 
bring up a doughnut menu that will let you drop characters into 
the game. Click Kodu and he’ll appear. 

10 save your creation 
Congratulations! You’ve made your very first computer 

game. To save it, press [Escape] to return to the menu. Now click 
the house icon. Move your mouse down to ‘Save my world’. At the 
top of the screen you’ll see a space where you can enter your 
creation’s name. Next to that you’ll see a version number. When 
you’re done just click the ‘Save’ button. ■

8 Bring out the artillery
Press [Escape] and click Kodu. Right-click him when he 

appears and select ‘Program’. Click on ‘When+’ next to 2. Click 
‘Keyboard’, ‘Misc’ and then ‘Space’. Now click ‘Do+’ and select 
‘Shoot’, then ‘+’, then ‘Missile’. Test the game again and you should 
be able to move around and fire missiles at those pesky fish. 
When you hit one it should explode. You’ve made your first game! 

6 Program Kodu
With our hero in place, right-click him and select ‘Program’. 

Programming here doesn’t mean writing pages of code. Instead 
it involves adding rules to each character that govern how that 
character will behave in certain situations. Every instruction has 
a When part and a Do part. Start by clicking the ‘When’ icon and 
a circular menu will pop up. Click the ‘Keyboard’ button. 
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Learn how to…
Supercharge 
Windows 8

“Give a sluggish Windows 8 PC a boost  
of performance with these top tips 
that will keep it feeling like new.”

indows 8 is the fastest iteration of 
Microsoft’s operating system yet. 
If you’ve recently picked up a 

new PC, you’ll know what I mean – it 
really flies. But, like older versions of 
Windows, after a while it can start 
to lose its sprightliness if you 
don’t take proper care 
of your computer. 
Maintenance is the 
key here – to stop 
your machine from 
slowing down there are 
a variety of steps you must 
take, from cleaning out your 
hard drive that’s become bloated to 
disabling startup programs that built 
up over time and stop Windows from 
loading quickly. These are the more obvious 
things, but there are also other tricks that 
you can use to make your machine faster. 
Our favourite for power users is booting 
straight into the desktop mode when you 
start your PC, meaning you never have to 
see the Start screen again if you don’t like it.

1 Disable startup programs
When your PC boots, it loads various programs so they’re 

ready to use, but you can remove any you don’t use to cut your 
startup time. Hold the [Windows] key and press [Q] to open 
search, then type taskbar manager. A window will appear; if you 
don’t see much, click ‘More details’ to expand it. Click the ‘Start-up’ 
tab and right-click ‘Disable apps you don’t need at startup’.

2 Use a picture password
If your PC is secured with a password, you can speed things 

up by choosing a different method of logging in. Our favourite 
option is the picture password. Hold the [Windows] key and 
press [Q], then type picture password and select ‘Set up picture 
password’. Click on ‘Add’ underneath Picture Password, choose a 
picture and draw three gestures to set it up.

Your guide Nicholas Odantzis says…

W

Nick’s best tip
it ’s easily overlooked, but 
restarting your pC regularly 
will clear the memory and 
speed things up.

Step-by-step Enhance your PC’s performance

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

25 minutes
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7 Use high performance mode
If you’re running Windows 8 on a laptop, your first priority is 

normally saving battery power, but if you’re tethered to a mains 
outlet you can increase the performance of your machine by 
adjusting its power options. Hold the [Windows] key and press 
[Q], then type power and choose ‘Power options’. Click the arrow 
next to ‘Show additional plans’ and check ‘High performance’.

8 Clean and defrag
After a few months of adding and removing files and apps, 

you might find that your PC starts to feel a bit sluggish. The cure? 
Try doing a disk cleanup and defragging it. Tap [Windows] and 
[Q], and type disk cleanup. choose ‘Clear disk space by deleting 
unnecessary files’, check the boxes next to large file sizes and then 
click ‘Clean up system files’ and click ‘OK’. ■

5 Free up disk space
Once your hard drive is full of files and apps, performance 

will suffer. If you’re wondering whether your drive has reached 
this point, hold the [Windows] key and press [Q], then type disk 
and select ‘Clear disk space’ to see how much room you have. 
Try emptying the Recycle Bin if its bursting at the seams, or click 
‘See my application sizes’ to remove apps taking up lots of space.

3 Remove animations
Windows 8 has animations that play when you’re doing 

things such as opening windows. These demand a little extra 
power from your PC, so you can speed things up by turning them 
off. Hold the [Windows] key and press [Q], then type performance 
and click ‘Adjust the appearance and performance of Windows’. 
Check the box next to ‘Adjust for best performance’ to turn it off.

6 Boot straight to desktop
If you spend most of your time on the desktop in Windows 

8, you’ll be pleased to hear about this handy tweak which takes 
you straight to the desktop when you start up your PC. To do this, 
right-click the Taskbar, select ‘Properties’ from the menu, then 
click the ‘Navigation’ tab. Now tick the checkbox next to ‘When I 
sign in or close all applications… go to desktop’, and click ‘OK’.

4 Pin apps to Taskbar
You can pin your favourite Modern UI apps from the 

Start screen straight to the Taskbar – ideal if you mostly work 
in desktop mode but still want to use them. To pin them, go to 
the Start screen (tap the lower left corner to get there quickly), 
right-click an app you’d like to pin and select ‘Pin to Taskbar’. Back 
in desktop mode you’ll now see the app attached to the Taskbar.

Explore 
Supercharge Windows 8
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Learn how to…
Rename media 
files quickly

“FileBot renames your movie, 
music and TV files to make them 
easier to manage. Discover how!”

here are many good 
reasons for ensuring your 
TV, movie and music files 

are named up correctly. Not only 
does it make them easier to identify 
when browsing your hard drive, it 
also allows media-sharing solutions 
like Plex and Media Browser (see 
issue 100) to correctly download 
artwork and other information such 
as episode synopses for your media.

Renaming files by hand can be 
tricky and time-consuming, but 
FileBot is a free tool that can do all 
the hard work of renaming media, 
identifying unknown music tracks 
and downloading subtitles for your 
movies and TV shows for you. 

The step-by-step guide below 
reveals how it can help to get your 
media named correctly, while the 
annotation opposite will show you 
how to download and – if necessary 
– configure subtitles to add to your 
media collection.

1 First steps
Install FileBot from the cover disc – the setup file will 

automatically download the latest version of the program for you. 
Once it’s installed, choose ‘Start > All Programs > FileBot > FileBot’ 
to launch the program. In this tutorial we’ll first look at renaming 
TV shows, then explore movies, and finally show you how to 
rename music files using the program if necessary.

2 Select TV show
First, browse to the folder containing your TV episodes. 

Don’t try to add them all at once; assuming you’ve already 
organised them into logical folders, rename them in batches 
– say an entire series or just a season or two of a long-running US 
show. Now drag the folder or folders containing these episodes 
into the Original Files box in FileBot, where they’ll appear in a list.

Step-by-step Rename media with FileBot

Your guide Nick Peers says…
Subtitle vieweR
Click one of the 
results to download 
it to your PC, then 
double-click the 
download to view 
the subtitles and 
verify the match. T

Nick’s best tiP!
Check out my guide at www.
techradar.com/1155622 for 
even more advice and tips on 
naming your files.

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKill level

time tAKen

SuitAble foR

15 minutes
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3 Set naming format
Click the ‘Match’ button to reveal a drop-down menu and 

select ‘Edit format’ to choose a naming format for your files. Click 
one of the examples provided to select it. Alternatively, click the 
‘Syntax’ box to visit the FileBot website for a more dedicated 
explanation of how the naming convention works along with 
more examples you might like to consider using.

4 Tweak format
You can edit the format to your liking – use the ‘(x)=’ button 

to reveal a list of common bindings for more options, such as 
actors, airdate or genre. For most people, though, the simplest 
bindings – show title, season number, episode number and 
episode title – work best. To follow our lead, for example, type  
{n} – {s00e00} – {t} into the box and click ‘Use format’.

Jargon buster!
 binding

A command in {} 
symbols that FileBot 
uses to insert media 
information into a 
filename – for 
example, {t} inserts 
the title.

 illegal character
This is a character 
that cannot be used 
as part of a filename, 
such as the question 
mark (?) and colon (:) 
symbols.

 timing offset
A delay – set in 
microseconds – that 
ensures subtitles 
appear on screen in 
sync with the movie 
or TV episode’s audio 
soundtrack.

QuicK SeARch
Drag the movie or TV episode file 
onto the blue button to start a 
quick search for relevant subtitles. 

Review ReSultS
Click the down arrow next 
to the preferred result to 
see what other files have 
been found, then select the 
one you want. 

nAme And SAve
Choose how the subtitle 
file should be named 
(‘Match video and 
language’ is best) and click 
‘Download’ to save it. 

Subtitle SeARch
Alternatively, type 
in the name of the 
film or show you’re 
looking for, select 
the closest match 
and click ‘Select’. 

expoRt
Right-click your chosen 
subtitles file and choose 
‘Export’ to save a copy with 
different encoding, format 
and even timing offset. 

Explore 
Rename media files quickly
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9 Reverse changes
You can view your renaming history and undo any changes 

by clicking the notebook icon at the bottom of the Original Files 
pane. Select the sequence in the top pane to reveal the files 
renamed during that operation. Once you’ve located the wrongly 
named file or files, hold down [Ctrl] as you click each one to select 
them, then click ‘Revert selection’ to restore the original filename.

7 Rename movies
It’s a similar process for movies; right-click ‘Match’ and 

choose a database. Again, TheMovieDB is often the best choice. 
If prompted, retype the name of any misspelled or unrecognised 
movie to give FileBot a better chance of finding it. The default 
naming format for renamed files is title (year) – right-click ‘Match’ 
and choose ‘Edit format > Switch to movie format’ to change it.

5  Choose search engine
Right-click the ‘Match’ button again. This time, choose one 

of the four Episode Mode options. TheTVDB is typically the best 
choice, so start with that. If multiple matches are found, review 
them in the pop-up box, select the one you think is correct and 
click ‘Choose’. If you’ve chosen the right show, you should see the 
suggested new name for each file appear correctly on the right.

10 Your media, renamed
And there you have it – a quick and easy way to name your 

media files so they’re easy for both you and any media streaming 
service to identify. Don’t forget to check out other parts of the 
program too; click ‘Subtitles’ to download subtitles using the 
annotation as a guide, or select ‘Episodes’ to track down a 
complete list of episodes for any show in your collection. ■

8  Rename music files
Drag mislabelled or unidentified music tracks into FileBot 

and choose ‘Match > AcoustID’ to see if it can find matches based 
on the file content. Music can be harder to find and verify, so work 
in smaller batches, playing each track to check it’s been matched 
correctly before clicking ‘Rename’. Choose ‘Match > Edit format > 
Switch to music format’ to change the naming convention.

6 Review and rename
Pay particular attention to results marked in red or pink – 

these are matches that FileBot thinks may be incorrect. Remove 
mismatches by selecting the episode and clicking the ‘X’ button. 
Once you’re happy with all the matches, click ‘Rename’. If any titles 
contain illegal characters that can’t be used in filenames, FileBot 
will display a warning. Click ‘Validate’ to fix them.
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Learn how to…
Master the Windows 7 
Action Center

“Learn all about the Action Center – it’s your 
one stop shop for all system messages, warnings 
and updates within Windows 7.”

ction Center is a feature in 
Windows 7, which brings 
together all the various 

warnings and pop-up messages you 
see in Windows, and makes them easy 
to understand and act on. 

Action Center checks many security 
and maintenance-related items on 
your PC, helping you keep it in good 
order. When I upgraded my PC to 
Windows 7, Action Center told 
me about several applications that I 
needed to upgrade to keep my system 
secure. It’s extremely useful!

Action Center monitors your PC, and 
when something important changes 
– if your antivirus software goes out of 
date, for example – it will let you know 
straight away by making a pop-up 
appear from its taskbar icon. The 
program’s status within Action Center 
will change colour to reflect the 
severity of the message. Windows 7 will 
then recommend a course of action so 
you can resolve it quickly and easily.

A

Your guide Dan Grabham says…

dan’s best tip!
Click on the ‘troubleshooting’ 
link within Action Center to 
access the troubleshooting 
area of the Control panel .

Step-by-stepStep-by-step Customise the Action Center

1 See the notifications
The Windows 7 Action Center appears as a small icon in the 

notification area on your taskbar. Right-click the icon and you’ll 
see a pop-up telling you about outstanding security issues and any 
other problems. As you can see, my computer has one issue that 
needs my attention at the moment. You’ll probably have a few 
more, especially on a fresh install of Windows 7.

2 Defending your PC 
Click ‘Open Action Center’ on the pop-up window to begin. 

You can also right-click the icon or search for it in your Start menu 
if you prefer. As you can see, there are three issues displayed on this 
screen, not just one. Action Center has also noticed that I haven’t 
set up Windows Backup to save copies of my files, and that 
Windows Defender hasn’t been updated. 

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TIME TAKEn

SuITAbLE for

15 minutes
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7 Change settings 
You can adjust how Action Center works from the main 

window. To get started, click on ‘Change Action Center settings’. 
Here you can select the types of problems you want to be warned 
about, including security and maintenance issues. You can also use 
the link at the bottom to fine-tune Windows Update – the system 
Windows 7 uses to download updates to your computer.

5 Expand and contract 
You can display or hide extra information using 

the arrows on the top right of each section. Here you 
can see what activities are being monitored – my 
system is set to automatically check for solutions to 
problems, so it will look online for ways to fix any 
issues my PC encounters.

3 Perform the action 
Each issue has an action alongside it. Here, 

I’ve set Windows Defender to update. This is what 
the screen looks like when you click ‘View message 
details’ to see extra information. The Action Center 
will recommend the best course – here it’s 
downloading an update from the internet.

8 And that’s it! 
Once you’ve sorted out the issues shown in your Action 

Center, you’ll have a window that looks like this – rather empty. 
Your computer is now secure and up to date! Windows may flag up 
some new issues from time to time though, such as new updates 
for software and drivers, as well as any issues with your antivirus 
program, backups or internet security. ■

6 Get on top  
of security 

While you’re having a look 
around and getting to 
know the Windows 7 Action 
Center, it’s definitely worth 
taking some time to check 
out the contents of the 
Security section. In this area 
you’ll be able to see exactly 
what kind of anti-spyware 
and antivirus protection you 
currently have installed on 
your computer, and find 
out whether you need to 
update it at the moment. 
Here you can see that 
Windows 7 is reporting that 
both Windows Defender 
and my third-party antivirus 
application are running 
smoothly, which is always 
good to hear!

4 Set backup 
Unless you’ve already configured it, you’re 

likely to be reminded about running Windows 
Backup. This is essential, especially if you don’t use 
any other backup tools. Even with Windows 7, 
computers aren’t infallible, so it’s good to know that 
your data will be safe no matter what.

Jargon buster!

 Notification area
The portion of the 
taskbar that displays 
icons for features that 
are always available.

 Windows Backup
This is the software 
within Windows 7 
that enables you to 
schedule backups of 
your important files.

 Windows Defender
An application that 
helps protect your  
PC against pop-ups 
and spyware.

Explore
Master the Action Center
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Learn how to…
Keep an eye on 
your network

“I demand full speed from my 
home network. If I’m not getting 
it, it’s time to find out why.” 

hese days, most of us are 
paying for high-speed 
internet connections. I know 

I am – I shell out a rather ridiculous 
fee for the fastest broadband 
available in my area. 

I need to get the most out of my 
investment and NetWorx is invaluable 
for keeping tabs on the performance 
of my network and defining just 
where any problems might lie. Has 
an Ethernet cable become trapped in 
a door, kinked and broken? Is a Wi-Fi 
signal being hampered by walls in 
the way? If you know what sort of 
speed you should be getting from 
your equipment, NetWorx is a great 
way to find out. 

NetWorx can monitor your whole 
network and your router too, so if all 
of your kit is functioning correctly 
you can pin the poor performance 
blame squarely on your broadband 
provider. There’s no sense paying for 
poor service.

1 Download and install
Get NetWorx either from your cover disc or from  

www.softperfect.com/products/networx. Run the installer and 
click ‘Next’ on each page. I recommend you install the Desk Band 
component because it lets you see your network traffic at a 
glance. Click ‘Finish’ at the end of the installation procedure  
and NetWorx will launch its initial configuration wizard.

2 Configure and align
You shouldn’t need to change much in the configuration 

wizard. You might want to use step 2 to define which connection 
you’re watching if you use both wired and wireless, but ‘All 
connections’ is fine for most purposes. Once you’ve clicked ‘Finish’, 
an icon will appear in your taskbar. If it disappears, as it did on 
mine, expand the taskbar and drag the icon onto the main area.

Step-by-step Monitor traffic on your network

Your guide Alex Cox says…

Trace rouTe
Type in any address to check its 
connection. Sometimes a trace 
will time out, which means the 
signal is taking too long to 
travel. If this happens, try 
increasing the Wait Timeout 
value and searching again. 

Ping
Ping is one of the core 
commands in network 
diagnostics, and NetWorx gives 
you a quick way to use it. Try 
pinging local IP addresses, and 
addresses on the internet too.

T
Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

at a glance…
SKiLL LeVeL

Time TaKen

SuiTabLe for

20 minutes
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3 See the Desk Band
The Desk Band is hidden by default, which is rather silly 

because it’s a tool that’s only useful if it’s visible all the time. 
Right-click your Taskbar, go to ‘Toolbars’ and click ‘NetWorx Desk 
Bar’ to bring it to the forefront. You can drag the slider on the left 
to extend or shrink the graph, which updates whenever there’s 
any network traffic, or right-click it to access the NetWorx menu.

4 Alternate graph
If you don’t want to use the Desk Band, you can see an 

always-on-top graph of your network traffic by right-clicking the 
taskbar icon and selecting ‘Show graph’. You can drag its corners 
to make it bigger if you need to. Green spikes represent download 
traffic, red spikes represent upload traffic and yellow spikes 
correspond to times when traffic was moving in both directions.

Jargon buster!
 iP address

This is a numerical 
address assigned to 
each computer on a 
network. Your PC 
has one, your router 
has one, and your 
internet connection 
has one too. To find 
out your local IP 
address, press 
[Windows] and type 
cmd, then ipconfig.

QuoTa
You can set daily, weekly or 
monthly quotas on this panel, and 
even allocate peak and off-peak 
hours if your ISP imposes data 
caps at certain times of the day. 
Just use the ‘Setup’ button.

Two graPhS
The Desk Bar and the graph 
window do the same job, 
but you can use them both 
together – and if you reset 
one by right clicking it, you 
can view recent and historical 
graphics at once.

SeTTingS
If you’re serious about monitoring your whole network, 
make sure NetWorx is installed on every machine and 
that the ‘Load on Windows startup’ box is checked. 

SPeed meTer
Run this when you start your 
machine and keep an eye on 
the maximum transfer rate to 
make sure you’re getting the 
full capacity from your network 
connection and broadband.

Explore 
Monitor your network
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9 Specific connections
If you have a wired and a wireless network connection, you 

can restrict NetWorx to one or the other in the Settings page. In 
the Main tab, click the drop-down box under ‘Monitored 
interfaces’ and select the appropriate option. You can also monitor 
your router rather than a single computer – useful in a family 
home. Click the link below and enter the IP address of your router.

7 Test network connections
Say you’ve got a network issue. Although you can’t use 

NetWorx to solve it, you can use its tools to find out exactly where 
the problem lies. Start with the Ping window, which sends a quick 
sonar-like ‘ping’ to any IP address you like. If the message is 
returned, the connection is working. If it’s not, or if it takes a long 
time to bounce back, there’s a problem between the computers.

5 Manage your use
Right-click the Taskbar icon and select ‘Quota’. You can use 

this interface to define the maximum amount of network traffic 
you want to use over a specific period, which is useful if you have 
a capped internet connection. NetWorx won’t cut your network 
off, but it will warn you when you’re approaching your limit. Click 
‘Setup’, choose your options and input your intended limit in KB.

10 Notify and synchronise
Two other areas to note on the Settings window are the 

Notifications tab, in which you can ask NetWorx to tell you if 
certain conditions are met, and the Synchronisation section of  
the Advanced tab, which collects data from all local machines  
on which NetWorx is installed. Once that’s done, you’re watching 
your whole network for the slightest hiccup. ■

8 Check the internet
A trace route is much like a ping, except it bounces from 

your machine to a particular computer on the web, giving you 
data about the route it’s taken and the number of ‘hops’ taken 
along the way. Enter a web address on the Trace Route screen and 
it will attempt to get a reply from that site. If it doesn’t, look at the 
route taken and you should be able to tell where the problem is.

6 Check your speeds
The Speed Meter section gives you details of your network 

speed, or the lack of it. We’d suggest running the monitor at 
the start of a typical day and checking its results at the end, or 
running it before a heavy download or upload to get a good 
handle on the speed levels you’re achieving. Click the disc icon 
to save your results, so you can compare multiple days later on.
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Learn how to…
Extend your 
battery life

t’s easier than you might 
think to give your laptop’s 
battery a longer life. 

Although I can’t help you transform 
older batteries that have already 
been through the mill, I can say 
that you will be able to stockpile 
power by performing a few simple 
housekeeping tasks on your laptop. 

It’s important to look after your 
laptop battery. Even though the 
latest Lithium Ion batteries can 
be recharged and discharged at 
will, we still find it’s worth putting 
them through a full charge cycle 
regularly. Should your battery be 
completely shot, it’s worth looking 
around for a replacement. Ebay 
is a good place to look, but make 
sure you get a new battery – 
you don’t want somebody else’s 
cast-offs. The tips here are mainly 
for Windows 7, but you can perform 
similar measures if you’re using an 
older version of Windows, too. 

1 Your battery power
The amount of life left in your battery is shown by the icon 

in your Windows 7 notifications area, or your system tray if you’re 
using an older version of Windows. By clicking on the icon you 
can see the exact length of time your battery has left as well as 
your current power plan – I’ll be looking at that next. 

2 View Power Options
When you left-click on the battery icon, you’ll be able to 

see this menu. I’ll look at the Windows Mobility Center shortly 
but for now, just select Power Options. Coincidentally, the other 
option on this menu enables you to turn system icons on or off 
in the notifications area.

Step-by-step Save battery power

I

“You can make your laptop  
battery last all day with just a  
few simple power-saving tips.”

Your guide Dan Grabham says…

ThE SLEEp buTTon
This can also help in 
terms of managing 
your machine’s power 
consumption. Leaving 
your laptop for a few 
minutes? Why not put 
it to sleep first?

CLoSIng ThE LId
I always recommend 
that you opt to have 
your computer sleep 
when you close its lid. 
I’d certainly never 
leave a laptop fully on 
when its lid is closed 
– what’s the point?

Anyone can do it 
Straightforward
Tricky in parts

 Windows 8
 Windows 7
 Windows Vista
 Windows XP

At a glance…
SKILL LEVEL

TImE TAKEn

SuITAbLE for

30 minutes
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Find the solution! Stop unwanted programs 
When running on batteries, stop unnecessary programs  
running – use the Task Manager to help identify them. 

3 Select a power plan
The Power Options window enables you to change settings 

that affect how your laptop consumes power. That means you 
can conserve energy when you need to be frugal and give your 
machine a boost when you need more performance. Click on 
‘Change Plan Settings’ next to the High Performance label. 

4 Power computing
As you can see, the default settings for this power plan 

always leave the display on and never put the computer to sleep, 
regardless of whether it has its power adapter plugged in or not. 
Now go back out of this plan by clicking Cancel, then select 
‘Change Plan Settings’ next to the Power Saver label. 

Jargon buster!
 Charge cycle

A full recharge and 
discharge. Some 
batteries have a cited 
number of recharges 
before they lose 
some effectiveness 
– depending on how 
you use it, of course. 
Batteries deteriorate 
slowly with age, 
whatever your 
manufacturer says, 
so it’s always a good 
idea to look after it 
as much as possible. 

 Lithium Ion
The type of battery 
commonly used in 
laptops as well as 
other electronics 
devices, such as 
digital cameras.

dEfInE powEr buTTonS
Choosing what your sleep 
buttons do can have a great 
impact on your system’s power 
consumption, so it’s important 
to choose the right options.

bATTEry or pLuggEd In?
Changing some settings – such 
as what happens when you 
close your lid – for when your 
laptop is plugged in or relying 
on batteries, can create good 
habits and save even more 
power in the long run. 

Explore 
Laptop battery
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9 Advanced mobility
While the Power Options windows are something to take  

a look at every so often, the Windows Mobility Center (also 
accessed by clicking on the battery icon) might be something  
you keep open whenever you’re not plugged in. It enables you  
to rapidly change settings that affect your power consumption. 

7 Restore defaults
Many laptops also include a Balanced power plan, which 

should offer a good trade-off between frugality and performance. 
If you’ve made changes to one of the standard power plans such 
as Power Saver or High Performance, you can always undo these 
by clicking ‘Restore default settings’ in the plan window. 

5 Frugal computing
This plan has a much reduced power consumption: as you 

can see, the display will turn off after a short time, and the laptop 
will sleep after just 10 minutes of non-use if it’s on battery power 
– ideal when you’re not plugged in. We’ll now look at editing your 
current plan, so leave of this plan and go to your default.

10 Turn off wireless
As well as changing your power plan and seeing at a 

glance how much power you have left, you can also use Windows 
Mobility Center to turn your wireless networking on and off.  
Wi-Fi is great, but if you’re not using it then you can save a lot of 
juice by turning it off completely. 

8 Advanced settings
There is also a Change Advanced Power Settings option. 

This enables you to change other power options normally 
micro-managed by Windows, such as the time after which it rests 
your hard disk. Tweaking such things may affect performance, but 
if battery life is your priority, you may find it worthwhile. 

6 Edit a plan
You can choose any of the plans shown or create your own 

using the option provided in the main window. Your laptop might 
also have a bespoke power plan created by the manufacturer that 
isn’t necessarily the best for conserving power. You can change 
any of these settings; just click ‘Save changes’ after doing so.
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15 Dim your screen
This is probably the most important step of the lot – your 

display is responsible for a lot of the power drawn from your 
laptop. Some laptop screens have been known to account for up 
to 40 per cent of the power used at any one time. Dim your screen 
using the keyboard shortcuts shown. 

13 Stop scanning
If your laptop has any security software 

installed on it, ensure that it isn’t set to scan when 
you’re running on batteries – this can rapidly 
consume power and needs to be nipped in the bud. 
This also goes for Windows Defender, which you 
can see scanning my machine here. 

11 Wi-Fi switches
Some laptops have hardware switches that 

turn off the wireless card completely, while others, 
such as this Dell Inspiron, use Function keys to do 
the same thing – this usually turns off Bluetooth, 
too. You’ll be able to tell if it’s still on by the relevant 
LEDs at the top of your keyboard. 

16 Longer life
You’ve now learned how to increase your laptop’s battery 

life and reduce your power consumption. If you only remember 
one thing, take heed of the effect of bright screens. If you’ve  
only got a few minutes power left, drop the brightness right 
down and you’ll be able to use your system for longer. ■

14 Mute your 
volume

This might seem like just  
a small thing to change, but 
it can make a big difference 
to the life of your battery. 
The sound systems built 
into some laptops are quite 
substantial, so don’t play 
music at high volume or 
you’ll drain your power. 
Turn the sound down or, 
better still, use the function 
key shortcut to mute your 
system completely. That 
way you won’t get taken 
unawares by websites 
playing their own annoying 
soundtracks – and it’s 
a great way to avoid 
upsetting other people if 
you’re using your laptop in 
a cafe or on the train.

12 Stop your DVD drive
Your DVD drive is a major consumer of battery 

life – even if you’re not using it. Discs can spin at 
strange moments, so if you have anything in your 
drive, take it out. And if you absolutely have to use 
the drive while on battery power, it can be worth 
copying the files to your desktop to reduce disc use. 

Jargon buster!
 function keys

The keys along the 
top of your keyboard 
generally have extra 
functions, such as 
turning off Wi-Fi or 
muting your laptop. 
You’ll often see their 
second function 
printed in blue, and 
you usually have to 
press these keys in 
tandem with the [Fn] 
key in the bottom-
left of your keyboard 
(also coloured blue) 
to make them work. 

Explore 
Laptop battery
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32  
new things 

your PC Can Do 
Push your PC to the limit to discover the breadth of 
tasks it can perform. You might be surprised...
Suitable for all versions of Windows

S
ometimes we have a 
tendency to get caught up 
in the mundane. We’ll all 
spend days of our lives 

pushing messages to and from social 
media, typing up long important 
documents, or organising countless 
photos of friends and family. 

These things are all pretty essential, 
and we’re not about to suggest that 
you pack in work or abandon your 
loved ones, but you have in front of you 
an amazing thing: a computer far more 
powerful than those that sent man to 
the moon. And what are you doing with 
it? Basically, when all is said and done, 
absolutely nothing. And that’s a shame.

This is why we’ve decided to find 
some of the most amazing things your 
computer is capable of and bring them 
to you. Things that you probably hadn’t 
even thought were possible. Because 
your PC isn’t just a computer. It’s a 
musical instrument. It’s an Android 
phone. It’s a teacher, an explorer, a 
sculptor and even a time machine. 
And what’s more, it is all these things 
right now. No extra hardware or costly 
software needed.

So please check out our list and tell 
us how you get on. It’s time to broaden 
your horizons, do something special 
with your PC, and go beyond the 
day-to-day of Windows. Enjoy!
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LISTEN UP Just drag WebSDR’s  
yellow marker along the ‘waterfall’ 

display to tune in to interesting signals 

PLAY AROUND AudioSauna has a keyboard and everything else you need to start making tunes

2 Create your 
oWn musiC

You don’t need to download or install 
anything to start making cool electronic 
music. AudioSauna Studio (www.
audiosauna.com/studio) gives you all the 
tools you need in a web browser. There’s 
everything from configurable analogue 
synths and FM synths to samplers, along 
with an easy to use virtual keyboard and 
piano roll layout. Whether you’re sketching 
out your next magnum opus or just after a 
simple beat, you can make it here.

3 sloW doWn 
songs

Paul’s Extreme Sound Stretch (http://
hypermammut.sourceforge.net/paulstretch) 

1 enjoy short Wave radio
A software-defined radio is a clever tool 
that captures an entire slice of radio bands 
and allows you to tune in to whichever 
frequency you like in real time. There are 
plenty of aerials hooked up to web-based 
receivers the world over; visit http://
websdr.org to find the best of them, 
and have fun exploring the vast array 
of short wave transmissions out 
there. If you’re interested in making 
your own, you can do so with a 
fairly standard USB TV receiver – 
check out http://bit.ly/1u2ZI8B to 
find out how.
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is an amazing bit of software that takes an 
audio file, stretches it to an extreme length, 
adds something called spectral smoothing, 
then spits out amazing ambient 
masterpieces. Make a tune 800 per cent 
longer and barely a whisper of it will be 
retained, but the end product will be 
fascinating and awesome.

4 learn a neW 
language

Fancy brushing up on your secondary 
school French? Feel like picking up an 
entirely new language, or learning 
something else entirely? Memrise (www.
memrise.com) mixes science, fun and a 
big community to create an innovative 
way to learn just about everything. It’s all 
based around tried and tested memory 
improvement techniques, and you can track 
your progress on any of the huge number 
of courses as you go.

5 see the World 
From home

The very first webcam was set up pointing 
at a pot of coffee at the University of 
Cambridge, so engineers could know how 
much of their precious caffeine remained. 
Now webcams are pointing at just about 
everything, everywhere. If you fancy taking 
a live sightseeing tour from your desk, just 
jump on to www.earthcamtv.com to see a 

live feed of webcams from around the 
world, or visit www.earthcam.com to be a 
bit more selective about your viewing.

6 try role- 
playing games

Ah, Dungeons and Dragons – a brilliant and 
immersive game so often ruined by the 
unwashed and the antisocial. But we’re here 
to tell you that there’s a better way to get 
your tabletop RPG fix: http://roll20.net has all 
the dice, tools, maps and tokens required for 
an online adventure. All you need to do is 
find a dungeon master. 

7 Create a 
board game

Vassal (www.vassalengine.org) is similar 
to roll20, which we mentioned previously, 
but with one big difference: it’s focused 
exclusively on the world of board gaming. 
Users have generated rule sets that let you 
play just about every popular board game 
online against your friends, and with a bit of 
effort you’ll even be able to make your own. 
It’s perfect for testing out those game ideas 
you’ve had rolling around in your head like 
so many six-sided dice.

8 play ClassiC 
games

If you’ve been around computers for a while, 
you’ll probably remember the familiar and 
haunting skirl of the Sinclair ZX Spectrum, 
as it took five minutes to load a game that 
may or may not be awful. Well, you can 
relive those days – and skip the interminable 
loading – with QAOP, an online Speccy 
emulator available to download free at 
http://torinak.com/qaop. Or if you’re after 
a more specific title, World of Spectrum 
(www.worldofspectrum.org) has an 
extensive archive of just about everything 
ever released for Sir Clive’s little wonder, all 
playable on desktop emulators, which are 
also available from the site.

OLD SCHOOL QAOP’s default control scheme is, of course, the classic Spectrum QAOP

LOOK OUT What will you see on 
Earthcam TV? Be on the lookout 

for suspicious activity!
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NINETIES CHARm michaelV’s emulation of Windows 3.1 even includes a spot of Minesweeper

9 go baCk  
in time

Telehack (www.telehack.com) is wonderful 
– it’s a simulation of the old days of online 
communication, with a tonne of emulated 
bulletin boards that you can dial into 
manually, and even a little hacking game 
built in. Once you get the hang of what 
you’re doing (perhaps with the help of the 
wiki at http://telehack.org) you’ll be hooked. 
If that feels like going back a little too far, 
check out Michael Vincent’s amazing 
website at www.michaelv.org, where he’s 
emulated Windows 3.1 to a T.

10 disCover  
neW musiC

There are hundreds of new bands and 
artists putting out music every day, but how 
do you find the next big hit and look cool 
before it’s cool? There’s http://musicrobot.
co.uk, a site dedicated to digging up the 
hottest new tunes for you. Or you could 
try going straight to the source; many of 
today’s brightest stars make themselves 
heard by putting up music on either www.
soundcloud.com or www.bandcamp.com, 
where you can listen for free.

11 redisCover 
old musiC

There’s plenty of free music around, but 
recorded music has been around long 
enough that there’s a vast swath of 
previously commercial audio that has 
outlived its copyright period. The Open 

Music Archive (www.openmusicarchive.org) 
collects much of this classic public domain 
content together, so you can download it 
and listen at your leisure. If you’re looking 
for a good lightweight player, we heartily 
recommend Foobar2000, which you can 
grab for free from www.foobar2000.org.

12 see the 
old Web

Many websites have been online, 
untouched, since they were first launched. 
Warner Brothers’ Space Jam site (www2.
warnerbros.com/spacejam/movie/jam.htm) 
is a shining example of classic web design, 
with its brutal repeating starfield 

background and innovative-for-1996 layout. 
But you don’t have to rely on things being 
left online; the Internet Archive’s Wayback 
Machine (http://archive.org/web) will show 
you sites as they existed in years past.

13 explore  
the galaxy

Celestia (www.shatters.net/celestia/news.
html) is a great if basic planetarium; 
synchronised in real time, it lets you jump to 
any object in the night sky and check it out. 
We’d also recommend checking out its rival 
Stellarium (www.stellarium.org/en_GB), 
which is slightly more complex and much 
more visually attractive. But if you really 

IN THE STARS You can set free, open source planetarium Stellarium to display constellations from other 
countries. It’s fascinating – Korea seems to have one known as ‘Toilet of Sky’
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want to feel how big space is, check out 
http://joshworth.com/dev/pixelspace. Its 
creator calls it “a tediously accurate scale 
model of the solar system”, and we’re not 
about to argue.

14 visit another 
planet

Google Maps is not merely limited to 
this planet. At http://google.com/moon 
you can find full maps of the Moon, with 
details of the Apollo landing sites; at http://
google.com/mars, you’ll get the same for 
the red planet. Install the increasingly 
misnamed Google Earth (http://google.
com/earth) and you can explore both 
extra-terrestrial bodies in three dimensions. 
As you’d expect, the satellite imagery isn’t as 
detailed as that of our own planet, but it’s 
still decent enough.

15 sCulpt in  digital Clay
Sculptris (http://pixologic.com/sculptris) is an 
easy-to-use, free version of the professional 
3D modelling tool ZBrush. You start with a 
simple ball of ‘clay’, and prod, pull and tweak 
it until you’ve made something presumably 
amazing but most likely terrifying and 
unsettling. It’s great fun to play with, and 
you might be surprised at the results you 
can achieve with no prior training or 
practise. Or you might be scared by them. 
One or the other.

16 appraise  
your home

Okay, you can’t get an exact valuation of 
your property without the intervention of 
an estate agent or two, but you can at least 

get an idea of what your home is worth 
(and what you might make if you were to 
sell it) by checking out recent sales on your 
street using sites like www.zoopla.co.uk 
or www.rightmove.com. There’s also the 
official Land Registry site (http://houseprices.
landregistry.gov.uk), which gives you an 
even more comprehensive look at house 
prices, with a heat map of popular areas.

17 redeCorate 
virtually

The Dulux Mousepainter site at www.dulux.
co.uk/web/visualizer cleverly allows you to 
upload a photo of your tattiest room and 
give it a fresh lick of paint. Yes, it’s all part of 
Dulux’s mission to sell you paint – who’d 
have thought – but it’s a great way to see if 

puce really does go with lime. IKEA offers 
similar tools; visit www.ikea.com/ms/en_GB/
rooms_ideas/splashplanners.html and install 
the plugin to start designing your new 
kitchen or filling your virtual rooms with 
digital flat pack shelves.

18 name your 
oFFspring

Who wants to follow the crowd? If you don’t 
want your newborn to get lost in a sea of 
other Olivers or Amelias in their class, check 
out http://names.darkgreener.com for a 
historical perspective on the most – and 
least – used names in recent years according 
to data from the Office of National Statistics. 
If you want to find naming trends in the 
USA, check out www.babynamewizard.

CLAY TERROR It can create amazing models in the right hands, but everything we’ve made with Sculptris has prevented us from sleeping at night

DIY SOS You can choose all sorts of options with IKEA’s tools. How ugly can you make your room?
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DOOR TO DOOR Whatever you’re interested in – food, fashion or fun ideas – there’s a service online that will deliver it straight to your home

com/voyager – this site goes back much 
further in time, too.

19 beCome a 
gourmet

If you want to try making something special 
– and who doesn’t fancy a nice crocodile 
burger or a good handful of chocolate 
ant wafers every once in a while – www.
findthatingredient.com is well worth a 
visit. Simply type in your postcode and the 
particular ingredient you’re hankering for, 
and it’ll find your nearest bricks-and-mortar 
or online stockist. And if you can’t even be 
bothered to look for a fancy 
ingredient, try www.
hellofresh.co.uk, a 
subscription service which 
will deliver a regular recipe, 
and all the ingredients you 
need to make it, direct to your door.

20 get yourselF 
on tv

There are plenty of websites you can visit 
if you’re interested in watching a show live 
as it’s being recorded – www.bbc.co.uk/
showsandtours/tickets, for example – but 
it’s just as easy to apply for a spot on the 
shows themselves; try www.bbc.co.uk/
beonashow or www.itv.com/beontv to 
try your luck. Alternatively, if you have a 
webcam, why not get involved with the on 
demand future of TV and record straight 
to YouTube? Just visit www.youtube.com/
my_webcam, allow the site access, and you 
can record footage from your PC’s camera 
without any additional software.

21 Fill your 
mailbox

Subscription services have exploded 
recently, and there are loads to try, many of 
which have signup offers which mean you 
can sample them without committing to 
a long term contract. Graze boxes (www.
graze.com) contain tasty snacks and fit 

through your letterbox. Toucan (www.
toucanbox.com) supplies fortnightly craft 
projects to keep your kids out of mischief. 
Trunkclub (www.trunkclub.com) is a service 
that sends you a personalised wardrobe 
selected by your own stylist. And why not 
subscribe to this fine magazine at www.
myfavouritemagazines.co.uk? You’ll save 
money and be the first to get every issue.

EAT UP We’d have to travel 100 miles 
to get hold of fresh crocodile meat. 
Perhaps we’ll give it a miss for now



LOOSE ENDS Ian’s Shoelace Site is just about the best site on the internet. Seriously
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DOWN YOU gO mr Dismount, 
we’re assured, is fully insured 
and completely indestructible

22 searCh For 
alien liFe

SETI – the Search for Extra Terrestrial 
Intelligence – employs gigantic radio 
telescopes pointed at the most interesting 
areas of the sky, but they capture so much 
data, there’s no way to process it all centrally. 
That’s where you come in: download BOINC 
using the instructions at http://setiathome.
ssl.berkeley.edu, and you can use your 
computer’s spare power to join over three 
million people in one of the world’s largest 
distributed computing projects. Maybe your 
PC will be the first to hear a message from 
another world…

23 break the 
enigma Code

Bletchley Park in Buckinghamshire will 
always be remembered for housing Britain’s 
crack team of codebreakers – including Alan 
Turing – during the Second World War. 
If you fancy encrypting and decrypting 
messages using the most secure code of 
the time, you can download an authentic 
Enigma simulator from http://users.telenet.
be/d.rijmenants/en/enigmasim.htm. The 
simulation includes removable rotors with 
authentic wiring, and is as baffling as you 
might expect, but there are instructions 
included and even a full gallery of different 
models of the Enigma machine.

24 abuse a 
stiCkman

It’s okay – Mr Dismount doesn’t mind if he 
takes a tumble. In Stair Dismount (http://
secretexit.com/freeware), a classic early 
display of ragdoll physics, it’s up to you to 
give your poor hapless soul a good shove 
and score points depending on just how 
brutally he falls. The same site also offers 
Truck Dismount, where you’re tasked with 

smashing Mr Dismount’s vehicle to cause 
him the most damage possible. 

25 WatCh 
WorldWide tv

Don’t fall for the scam hardware you might 
see advertised on less reputable websites – 
you don’t need a magical USB stick to tune 
in to TV from around the world – just the 
right source. http://wwitv.com will point 
you towards hundreds of free live streams 
of all sorts of TV stations, though bear in 
mind these are of variable quality, usually 
fluctuating between interesting and awful.

26 learn hoW  
to Code

There are plenty of resources online which 
will teach you to write your own programs, 
and even if you’re not intending on getting 
into coding as a job, it’s a great way to focus 
on joined up thinking. www.code.org hosts 
a string of kid-friendly online tutorials, but 
if you want something bit closer to the 
bone we wholeheartedly recommend 
www.codeacademy.com, which offers 
free courses that will teach you a variety 
of languages from the ground up. 

27 tie your 
shoelaCes

Well, not quite; your computer won’t 
actually fasten your laces for you. 
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gET gONE We’re not going to ask why you want to remove yourself from the internet. Keep that to yourself

Technology has not yet advanced that far. 
But we’re sure you’ve never thought of as 
many creative ways to lace up your footwear 
as Ian of Ian’s Shoelace Site (www.fieggen.
com/shoelace) has. No matter how many 
pairs of eyelets your shoes have, there’s 
comprehensive instructions for looping your 
laces, and even a guide to the Ian Knot, 
which the site’s owner claims is the ‘world’s 
fastest shoelace knot’.

28 give someone 
a loan

It’s very unlikely to make you a substantial 
profit, but you can apply your spare 
resources to help others who find 
themselves in need of some financial 
help www.zopa.com uses a system called 
peer-to-peer lending to match you with an 
individual seeking a loan, allowing you to 
invest from £10 upwards. The system is also 
known as lend-to-save, perhaps by way of 
apology for the low returns, but also to 
reflect the fact that your investment will 
trickle back to you gradually as it is repaid.

29 read ComiC 
books

There’s a huge community online dedicated 
to preserving and enjoying classic comic 
books from the so-called gold and silver 
ages, and many present day titles are 
released online too. Start by equipping 
yourself with a reader – www.cdisplayex.
com is a good option – then check out 
http://digitalcomicmuseum.com and http://
comicbookplus.com to find free out-of-
copyright titles to enjoy. 

30 run android 
apps

Those nifty games and apps aren’t reserved 
just for those with smartphones and tablets. 
With the BlueStacks App Player (www.
bluestacks.com) you can run the latest 
mobile software from your desktop. It’s not 
perfect – emulating a phone’s touchscreen 
with your mouse doesn’t always give good 
results – but with the Google Play Store built 
in, you can even download new apps easily.

31 hide yourselF 
online

Social media is lovely. Sometimes too lovely. 
Perhaps it’s got you into trouble, or attracted 

unwanted attention, or are wasting too 
much time. Sites like Facebook seem 
unwilling to actually delete your accounts, 
because your data makes them money. That 
is unless you follow the expert guides at 
www.accountkiller.com, which shows you 
how to rid yourself of social menaces.

32 print a  
giant poster

Your printer can probably only manage 
A4 pages, but the Rasterbator (www.
rasterbator.net) can convert an image into 
a series of circles, then create a PDF that 
splits it between multiple A4 sheets. You’ll 
need scissors, a steady hand and a lot of 
Blu-tack, but the results can be great. n



Microsoft has taken the wraps off its new version of 
Windows. Windows 10 brings back some old favourites, 
while looking into a cloud-first, web-first future.
By Graham Barlow, Dan Grabham

Introducing Windows 10

M icrosoft has announced the 
successor to Windows 8, cutting 
version 9 out of the chronological 

sequence altogether and jumping straight 
to version 10.

“I think we’d all say that Windows is at a 
threshold,” said Terry Myerson, executive 
vice president of the Operating System 
Group at Microsoft, introducing the new 
Windows 10 while making a joke about 
the well-known codename for the next 
OS, “and now its time for a new Windows.” 

The Windows 10 name came as a 
surprise to everyone, since most of the 
press had speculated for months that it 
would be logical for the new operating 
system to be called Windows 9. But as it 
turns out, that name wasn’t even in the 
running, and even Windows 10 wasn’t the 
first choice for Microsoft.

“Considering our One Microsoft 
strategy,” said Myerson, “the names of 
our products like Xbox One, OneNote 
and OneDrive, it’s obvious what the 
name should be: Windows One. But 
unfortunately, Windows 1.0 has been 
done by the giants that came before us 
[Bill Gates and the original version of 
Microsoft Windows], and because we’re 
not building an incremental product, the 
new Windows is Windows 10.”

Microsoft’s desire for the name to be a 
break with previous versions of Windows 
may be wishful thinking, as the features 

revealed so far look 
essentially like 
Windows 8 with a 
Start menu. In fact, 
Windows 10 seems 
like what Windows 8 should 
really have been in the first place.

Flexible and adaptable
This time though, it looks like the 
company is getting it right. For a start, 
Windows 10 will run on a wider range of 
devices than any previous version of the 
operating system – from tiny Internet of 
Things style gadgets to smartphones and 
tablets, all the way up to full-sized desktop 
PCs. In effect, the new OS is a continuation 
of Microsoft’s much criticised ‘Windows 
everywhere’ strategy, which stands in 
stark contrast to Apple’s use of separate 
operating systems for different devices – 
OS X for desktops and laptops, and iOS for 
tablets and smartphones.

After some trial and error, it seems that 
Microsoft might have hit the mark by 
giving users of Windows 10 an experience 
tailored the type of device they are 
using. So expect touchscreen features 
on touchscreen devices, and traditional 
desktop visuals for devices that come with 
mice and keyboards.

Microsoft’s ‘one product family’ 
approach has benefits for developers too, 
who will now be able to write an app just 
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“Windows 10 
seems like what 
Windows 8 should 
really have been 
in the first place”
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At A glAnCe:
What is it? Windows 10
When is it out? Some time in 2015
How much will it cost? Rumoured to be free, if you own Windows 8.
What hardware do I need? Your current system should run it fine.
Can I try it now? Yes! Head over to http://preview.windows.com to join 
the Windows Insider Programme and get the Technical Preview. Don’t 
install it on your main PC though, as it’s bound to be buggy at this stage.



once and have it run on a whole range of 
devices, with everything available from 
just one store. 

Down to business
But the real target for Windows 10 are 
what it calls ‘enterprise users’. It’s nothing 
to do with Star Trek – Microsoft wants 
to persuade the legions of businesses 
currently using Windows 7 to upgrade 
their PCs from to Windows 10. 

Many enterprise PCs are still running 
Windows 7, and companies’ system 
administrators have held off upgrading to 
Windows 8 because the change in user 
experience was too radical. With Windows 
10, Microsoft is aiming to create an 
experience that will be immediately 
familiar to people, whether they’re used 
to running Windows 7 or 8. That means 
some of the staples of Windows 7 

(including the Start menu) are going to 
make a welcome return. It also means that 
Windows 10 will be backwards compatible 
with all the apps you are running now. 
“Windows 10 is going to be our greatest 
enterprise platform ever,” said Myerson.

The new Start menu in Windows 10 
looks like a hybrid of Windows 7 and 8. 
All the familiar Start menu items from 
Windows 7 are there, including jump lists, 
All Programs (now called All Apps) and 
Search (which now looks for results the 
internet as well as your PC). There are also 
a few new additions, including a simple 
power button for restarting or turning 
off the PC and a ‘me’ tile at the top of 
the menu. Most impressive of all is a new 
sidebar that’s like a miniature version of 
the Windows 8 Start screen, complete 
with Live tiles, grafted onto the side of 
the menu. It initially looks as unnatural as 

it sounds, but you get used to it very 
quickly. The new Start menu is highly 
customisable, too; you can change the 
size of tiles with ease, and make the whole 
menu bigger or smaller.

Windows 10 also solves the issue in 
Windows 8 where Modern apps would 
run full screen, but traditional apps would 
exit to the desktop to run. Now all apps 
can run inside traditional, resizeable, 
windows on the desktop. They snap to the 
side of the screen when you move them 
around too, so it’s easy to make your 
desktop look nice when running multiple 
apps. In fact, there’s a new Windows 10 
feature called Snap Assist that suggests 
other open apps you might like to snap as 
well. Again, all these features are designed 
to make Windows 7 users feel at home in 
the new operating system, with a Taskbar 
and Start menu always visible. 

Windows manager Joe Belfiore was the 
first person to demonstrate Windows 10. 
“We want all these Windows 7 users to 
have the sentiment that, yesterday they 
were driving a first generation Prius, and 
when they got Windows 10 they didn’t 
have to learn to drive something new, 
but it was as if we got them a Tesla,” he 
explained. From our initial look at the 
new OS, we’d say that’s a fair analogy. 
It’s different, but works in a familiar way.

Multitasking
It’s no coincidence that productivity and 
multitasking are areas where Apple’s 
mobile devices are often criticised, and 
that’s clearly why they form a key part 
of Microsoft’s vision for Windows 10. 
A new button (currently called Task View, 
although its final name may change) lives 
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The new Task Manager 
provides handy previews

Windows 10 will run on  
a huge range of devices



Windows 10 makes it much easier to snap Windows 
into place so you can use multiple apps at once

in your taskbar and shows live thumbnails 
of all your running apps in one screen. 
Users of OS X will recognise it as being 
somewhat similar to the Exposé feature 
that Macs have had for a while now.

Microsoft has also added another 
feature familiar to Apple users – multiple 
desktops. These are accessible from Task 
View, and are simply a way of organising 
all your open apps into different areas – so 
you could have one desktop with all your 
financial apps open on, another for web 
browsing and email, and so on. 

Microsoft hasn’t forgotten users with 
keyboards either. Windows 10 makes 
some improvements to the traditional 
way of switching between apps with the 
classic [Alt]+[Tab] keyboard combination. 
Now it switches between virtual desktop 
as well as between apps, so you also 
switch to the desktop that contains the 
app you’ve selected. 

There’s even something interesting for 
the real hardcore Windows devotees who 
use the Command prompt (accessible 
by typing cmd into the Search bar) to 
perform tasks without navigating menus. 
Now you can use [Ctrl]+[C] and [Ctrl]+[V] 
to copy and paste text to and from the 
command prompt and Windows.

 
One for all
Belfiore conceded that all these little 
tweaks aren’t groundbreaking, but once 

you start to put them all together, 
Windows becomes a lot more useable, 
which has been the chief criticism of 
Windows 8 so far. We’d agree, but the 
real test is how Windows 10 is going to 
perform on the vast range of devices 
it is designed for – everything from 
touchscreen phones and tablets to 
laptops and full desktop systems.

To this end, Microsoft has introduced 
a new feature called Continuum. This 
enables Windows 10 to change its mode 
of operation for 2-in-1 convertible devices, 
such as the Lenovo Yoga and Microsoft 
Surface. When you’re using your Windows 
10 device as a tablet, Continuum gives 
you an appropriate view for a touchscreen 
(including full-screen apps, larger 
Start screen), but when you attach it to a 

keyboard and mouse, you get a traditional 
desktop, Start menu and taskbar. 
Continuum was actually too new for 
Belfiore to demonstrate live, so we were 
treated to a video of it working instead. It 
certainly looked promising and finally 
presented a solution to Microsoft’s 
problem of having one operating system 
work on all sorts of different devices.

Users of touchscreen devices will 
also be please to know that rumours of 
the death of the Charms bar have been 
greatly exaggerated – it’s still there if 
you swipe right. The screen that Belfiore 
demonstrated looked very much like the 
old Windows 8 Charms bar, but he said he 
expects the bar to look different in the 
finished version. 

Second wind
The presentation also contained a rare 
admission from Microsoft that it missed 
the mark with Windows 8 when it came to 
the idea of productivity on touch devices. 
“With Windows 8 we didn’t get it quite 
right,” admitted Belfiore. “With Windows 
10, we think we have a better approach.”

As for launch date and price, we didn’t 
get anything definite, but according to 
one graphic shown, the ‘launch wave’ 
looked like it would take place in the 
middle of 2015. Myerson said that early 
next year Microsoft will “start talking 
more about the consumer story” and at 
the Build conference in April, the company 
is intending to “continue the dialogue of 
Universal apps”.

In the end we didn’t get to explore 
much of Windows 10, but we liked what 
we saw. Microsoft is keen to emphasise 
that there are lots more consumer 

“Continuum enables Windows 10 
to change its mode of operation for 
convertible devices like the Surface”
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top 10 feAtures
1. Touch interface
Windows 10 is designed to appeal to 
experts and novices alike, and Microsoft 
was at pains to point out that it hasn’t 
given up on touch. The Charms bar is 
still there, for example, although we 
expect it to disappear if you’re using a 
non-touch PC (see ‘Continuum’, right).

Microsoft says it wants to ‘evolve’ the 
touch interface, which means it will be 
changing quite a bit. Task switching 
will no longer work on the left, and 
combined with alterations to Charms, 
that’s goodbye to most of the problem 
with Windows 8 . As Joe Belfiore said 
at the preview, “We want Windows 7 
users to feel like they upgraded from a 
[Toyota] Prius to a Tesla, but they don’t 
need to learn a new way to drive.”

2. Start menu
The most noticeable change is the new 
Start menu. It carries over some features 
from the Windows 8.1 Start screen, and 
can be resized to suit you.

features coming in Windows 10, so there 
are bound to be more announcements to 
look forward to over the next few months. 
And once the Technical Preview gets into 
people’s hands, more new features that 
have been baked-in already will no doubt 
be revealed. 

To us, it looks like Microsoft has done 
enough with Windows 10 to tempt the 
millions of Windows 7 users that it is 
targeting to upgrade. It already looks like 
there are good reasons for people to 
switch, but as it stands, the new operating 
system is hardly breaking new ground, but 
then we’ll hold back judgement until 
we’ve seen the final version. We’re hope 
there’s lots more in store for us in Windows 
10 that we just haven’t seen yet. n

3. Task View
There’s a new Task View in Windows 10, 
so users can switch between virtual 
desktops. Microsoft has acknowledged 
that many people use the Taskbar rather 
than shortcuts such as [Alt]+[Tab].

4. Snap Assist
A new Snap Assist feature helps you 
decide the best way to snap your apps. 
You can snap windows into new screens 
and tile Windows, just as you’ve been 
able to since Windows 2.0/3.0.

5. Command prompt
Another feature for power users is the 
ability to use keyboard shortcuts in the 
command prompt, so you will finally 
be able to copy and paste commands. 
Hardly groundbreaking, but very useful.

6. Windows Explorer
A new Home location is the new default 
view in Windows Explorer. There’s also a 
‘Share’ button on the Windows Explorer 
taskbar (we really hope this is in the 
context menu, too).

7. Continuum
Continuum is an on-the-fly mode for 
2-in-1 devices, which detects whether a 
keyboard has been added or removed 
and adapts the OS accordingly. For 
example, a back button appears to help 

you navigate the desktop with touch if 
the keyboard is detached. 

8. Universal apps
Windows 10 will also usher in a new app 
model: Universal Windows apps. This is 
the new name for Metro apps/Modern 
apps/Windows Store apps. Windows 10 
will be able to run on all devices from 
phones to servers, and there will be one 
app store for the lot. All older Windows 
Store apps will work with Windows 10.

9. Floating apps
Universal apps also work on the desktop 
and ‘float’ in their own windows. On the 
desktop, these apps have a ‘...’ icon that 
provides more options. This replaces the 
commands that used to be in the charms 
on the right-hand side of the screen.

10. Business and enterprise
Part of the reason why Microsoft 
demonstrated Windows 10 without 
all the consumer features is to show 
enterprises what new the operating 
system is capable of at this stage. This 
version of Windows will have plenty 
of features for businesses, including 
a customised store and protection 
for corporate data. Mobile Device 
Management will be supported for 
all devices, and Windows 10 will keep 
personal and corporate data separate.
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 WINDOWS HELP  HARDWARE FIXES  SOFTWARE SOLUTIONS  INTERNET TIPS

Windows
PRObLEmS INSTALLINg 
WINDOWS 8.1 

Q I have an Asus A6000U laptop 
with Windows XP installed. 

I’ve purchased a full copy of 
Windows 8.1 Pro and fitted a new 
128GB SSD. I’ve partitioned the SSD 
on my PC, but whenever I try to 
boot from the Windows 8.1 DVD 
it gets so far before rebooting 
and starting again. Why is this?
Robert Nesbitt

Nick’s solution
Robert had already 
verified that his laptop 
should be compatible 

with Windows 8.1, having 
previously run the Windows 
Upgrade Assistant, which revealed 
no critical problems. This rebooting 
issue during the initial stages 
of setup is quite commonly 
referenced on the internet, but 
having exhausted various 
possibilities we had a eureka 

moment. Robert’s laptop is 
eight years old and based on 32-bit 
architecture. The default Windows 
8.1 install DVD is now 64-bit, so we 
sent Robert off to obtain a 32-bit 
install DVD instead. Having 
downloaded and burned this, 
Robert reported he was able to 
install Windows 8.1 with no major 
problems, other than having to 
activate it over the phone.

Software
PAINT.NET PLUgIN ISSUE 

Q Every time I download and 
install Paint.NET plugins, 

Norton Internet Security flashes up 
a warning about them not being 
safe and removes some or all of 
them. I’ve checked on the forums 
and they are safe, so how do I stop 
Norton blocking them?
Kay Reed

Adam’s solution
The first thing to try is 
to open Norton Internet 
Security, click ‘Advanced’ 

and then select ‘Quarantine’. You 
will see a list of all the files it has 

Do you have a  
PC problem?  
Get in touch…
Email full details of your 
problem to the 
support team and we’ll 
do our best to help 
windowsmagazine@
futurenet.com

Plugin fix force 
norton to accept 

your Paint.nET 
plugins are safe
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Jargon buster!

blocked. Select the blocked file 
(in this case, a DLL) and click the 
‘Restore’ button. Make sure the 
‘Exclude this file’ option is ticked 
and click ‘Yes’. Unfortunately, in 
both Kay’s case and on our test 
machine, Norton seemed unwilling 
to accept our choice and blocked 
the file again the next time we 
launched Paint.NET.

Thankfully, there is a more 
permanent solution, but it does put 
your system at greater risk. Open 
Norton again, but this time click 
‘Settings’. Under the Computer tab, 
click ‘Configure’ next to ‘Item to 
exclude from Auto-Protect, SONAR 
and Download Intelligence 
Detection’. Click ‘Add > Folders’ and 
browse to C:\Program Files\paint.
net\Effects. Select this folder and 
click ‘OK’ twice. Norton will now 
ignore this folder going forward, 
and all your plugins should 
function normally.

Security
WHAT’S APNSETUP1.EXE? 

Q I recently stumbled across the 
above setup file on my PC. 

Right-clicking it and choosing 
‘Properties’ reveals that it’s a stub 
installer, linked to the Ask Partner 
Network. I immediately deleted it 
and emptied the trash. I have no 
idea where it came from, but is it 
malware and should I do more?
Angelika Schaumberg

matt’s solution
Thanks to Angelika’s 
detailed information, I 
was able to positively 

identify the file as part of a possible 
PUP (potentially unwanted 

program) infection. It’s probably 
related to a browser toolbar that 
may or may not have been 
installed, so I pointed Angelika to 
a free tool called the Junkware 
Removal Tool, which you can 
download from www.fosshub.com 
– search for Junkware Removal. 

Once downloaded, take a System 
Restore point, then close all your 
browsers and double-click the 
program to run it. It runs in a 
command prompt window and will 
scan your system, removing any 
PUPs it finds. The scan can take 10 
minutes or more to complete, and 
at the end will open a Notepad 
window revealing what it’s found 
and removed. Use the free 
Unchecky tool (www.unchecky.

Quickfire questions

Find the solution! Windows 8.1 upgrade FAQs
Visit http://bit.ly/1qJscWu for all the official advice you need.

I’ve tried to download the free 
version of OneNote without 
success – all I get is a prompt 
asking me to pay £59. What am 
I doing wrong?
Peter Childs

Once we verified that Peter 
was running Windows 7 or 8, 
we pointed him to www.
onenote.com/download.
 
I have a laptop with 2GB RAM 
and an SSD. Can ReadyBoost 
help speed it up?
Louis Friend

No – ReadyBoost utilises a USB 
flash drive for faster caching 
of memory to disk than a 
conventional hard drive, but 
SSDs are much quicker, and 
ReadyBoost will recognise this. 

“Use Unchecky to avoid 
installing potentially 
unwanted programs”

 Stub installer 
A tiny install utility whose sole 
job is to download the latest 
version of a program installer 
from the internet.
 

 SSD
Stands for solid-state drive. 
It stores data on flash memory 
chips rather than mechanically 
spinning platters. 

SavE xP 
give your old PC 
a new lease of 
life as a virtual 
machine

nETwork 
SoluTion 

western Digital’s 
MyCloud storage 

offers a good naS 
backup option

Support 
Technical help
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2 Select a Windows partition
Install AOMEI OneKey Recovery from 

the cover disc, then launch it. At the main 
screen, click OneKey System Backup. Your 
current Windows drive will be shown – select 
it by clicking on it, and once it’s highlighted in 
green, click ‘Next’.

1 Prepare your PC
Start by uninstalling any programs you 

don’t need and perform a general clean out 
of your system. Advanced users might also 
consider moving their data to a different 
partition or drive to help keep the size of the 
recovery partition down.

CREATE A CUSTOmISED 
RECOvERy PARTITION
Q I’m looking for a free tool that 

will simplify the creation of 
my own customised recovery 
partition. Can you help? 
Peter Harris

Nick’s solution
If you want a simple, 
fuss-free solution based 
on your current PC 

setup, then try AOMEI OneKey 
Recovery, which you’ll find on this 
month’s cover disc. It can, however, 
require a lot of free space for more 
mature Windows installations. 
Read on for details…

Quickfire questions

you as and when you need them 
from your new PC.

Internet
WHAT ARE my CLOUD 
STORAgE OPTIONS? 

Q I’m a little troubled about the 
idea of cloud storage, most 

notably privacy, price and ease of 
retrieval. In the past I’ve used a 
number of different services, but 
have never been completely 
satisfied with any of them. Do you 
think I would be better off buying 
an external hard drive instead? 
I want something that works 
quietly in the background and will 
back up my husband’s computer 
and mine with minimal fuss.
Joy Clough

Adam’s solution
It’s a good idea not to 
rely on a single form of 
backup (you never know 

when it might become corrupted 
or be destroyed), so we advised Joy 
to invest in a 1TB network attached 
hard drive that plugs directly into 
her router. This gives both her and 
her husband a convenient local 

Is there a handy tool for 
browsing my Media Browser 
media library without opening 
my web browser?
Dale Johnstone

Right-click the Media Browser 
notification area icon and 
choose ‘Open library viewer’. 
You can also use this to browse 
by user to see which files they 
can access.
 
How can I transfer music from 
my old iPhone to my new 
Moto G Android smartphone?
Tessa Cooper

KiwiG PhonTunes (www.
kiwigeeker.com) allows you 
to transfer music directly 
between mobile devices using 
your PC as an intermediary – 
check out our tutorial in issue 
97 for more details.
 
What’s the simplest way to 
access my PC’s apps from my 
iPad? I tried TeamViewer, but 
it’s very fiddly.
Franz bauer

Parallels Access (www.parallels.
com) is a great cross-platform 
solution that, rather than 
showing your PC’s desktop on 
your iPad’s screen, lets you pick 
a program from your PC, then 
open it in a window optimised 
for your mobile display. A 
14-day trial is available, after 
which it’s $19.99 a year.

com) to help block future possible 
PUP installations.

Windows
CAN I PRESERvE my 
TRUSTy XP 
INSTALLATION? 

Q I’m accepting the inevitable 
and ‘moving on up’ to 

Windows 7 and a new PC. I’m 
reluctant to leave my trusty 
Windows XP computer behind 
though, and there’s no room to run 
both side-by-side. What can I do?
Rob Powell

graham’s solution
Many people are 
worried about 
accidentally leaving files 

behind or finding trusted programs 
no longer work when upgrading to 
a new PC, but a free program called 
VirtualXP Free offers a novel 
solution to the problem. You’ll find 
it on the cover disc, and its job is to 
convert your existing Windows XP 
PC into a virtual PC you can set up 
and run on your new PC through a 
handy program called VirtualBox 
(available to download free from 
www.virtualbox.org).

The program is simple to use: 
install it on your XP computer, then 
run through the straightforward 
wizard to select which drives or 
partitions you’d like to convert, and 
where to put each virtual hard 
drive file (in VHD format) – typically 
an external hard drive is best. Once 
the program has created your 
virtual drives, switch to your new 
PC, install VirtualBox on that, then 
set up a new virtual Windows XP 
machine closely matching the 
specifications of your old PC, 
attaching the VHD file or files to it. 
When you fire up your virtual PC, 
you’ll find all your programs, data 
and settings exactly as you left 
them, ready to continue serving 

fix CorruPTion 
remove corrupt 
program entries 
using CCleaner.
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Jargon buster!
 

 virtual hard drive 
An exact copy of a physical 
hard drive that is stored in a 
single file, allowing it to be 
used as storage for a virtual PC.
 

 Recovery partition
A special partition that houses 
the files required to restore a 
computer to a specific state. It’s 
usually hidden from view in 
Windows to prevent it from 
being accidentally accessed 
and possibly damaged. 

Do you have  
a PC problem?  
Get in touch…
Email full details of 
your problem to the 
support team and we’ll 
do our best to help 
windowsmagazine@
futurenet.com

4 Restore your PC
In future you can restore your recovery 

partition one of two ways. If you can boot 
into Windows, launch AOMEI OneKey 
Recovery and click OneKey System Recovery; 
if not, press [A] when prompted on startup to 
access the recovery options.

3 Review changes
AOMEI OneKey Recovery will then 

display the proposed changes to your system. 
If everything looks good, click ‘Start Backup’ 
and follow the prompts. If OneKey Recovery 
finds errors on the drive, for example, it’ll 
offer to repair them first.

“It’s a good idea not to rely on a single form 
of backup – you never know when it might 

become corrupted or be destroyed”

backup that’s quick and easy to 
configure with the right software. 
Joy was running Windows 7, so a 
third-party backup tool is required 
that supports network drives, such 
as Comodo Backup (http://backup.
comodo.com), which makes it easy 
to set up different profiles to back 
up all your documents, photos, 
video and other files.

We’d then suggest Joy switches 
to a free cloud backup solution for 
documents, photos and other 
smaller files, offering a second level 
of backup. Microsoft’s OneDrive is 
simple to set up, runs automatically 
in the background and offers up to 
25GB free storage for each user, 
more than enough for Joy and her 
husband’s needs. Like most cloud 
backup providers, OneDrive 
automatically encrypts your data 
for privacy, but you can add 
another layer of encryption to 
particularly sensitive files before 
uploading them using a free tool 
called BoxCryptor (free for personal 
use from www.boxcryptor.com).

Windows
HOW CAN I REPAIR 
CORRUPTION IN THE 
CONTROL PANEL? 

Q Something has happened to 
the Add or Remove Programs 

Control Panel on my Windows XP 
PC. It now only lists 10 entries. 
Presumably this is being caused 
by a corrupt file or Registry entry 
somewhere, but I don’t know how 
to fix it. Can you help, please?
gareth Davies

Simon’s solution
We contacted Gareth 
to first check that the 
list wasn’t, in fact, 

incomplete – and after scrolling 
down past lots of blank space, he 
discovered all the missing entries. 
The error comes from a corrupt 

Registry entry linked to one 
program’s display icon in this list, 
so removing the program’s entry 
(not the program itself) will solve 
the issue. Before going ahead, 
make a note of the location of the 
offending app’s uninstaller (look 
in the ‘Start > All Programs’ list for 
a convenient shortcut, or in the 
program’s own folder).

To remove the entry from the list, 
first identify it by making a note of 
the programs immediately above 
and below the empty space, then 
use a tool like CCleaner (on the 
disc). Browse to the Tools > 
Uninstall section, locate the two 
programs you previously identified 
– you’ll find a third program 
between them, which is the 
offender. Right-click this and 
choose ‘Delete’. Once this is done, 
the list should appear correctly.

Backing up
HOW DO I CLEAR FILE 
HISTORy SPACE? 

Q I’m running out of space on 
my backup drive and I think 

Windows 8’s File History is to 
blame. How can I free up space?
Claire Unsworth

graham’s solution
Open File History (press 
[Win]+[X], choose 
‘Control Panel’ and 

search for File History). Choose 
‘Advanced settings’ to tweak how 
often it saves file updates, and how 
much of the drive to use. You can 
also temporarily free up space via 
the ‘Clean up versions’ link. When 
choosing the latter, select how 
far back you want to go, but be 
prepared for a wait as your PC 
clears out thousands of files! ■

frEE SPaCE 
reclaim valuable 
drive space from 
file History with 
our tips

Support 
Technical help
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 new hardware   essential accessories   latest GaMes

the days of your 
computer being a 
grey box on your 
desk are long gone. 
You can now take 

your PC with you everywhere 
you go, ready for whenever 
you want to type out a report 
or relax and have fun.

This month we’ve been 
listening to a selection of the 
best devices for streaming 
music from your PC, phone or 
any other device. These little 
wonders will let you enjoy your 
favourite tunes anywhere in 
your home! We’ve also taken 
a look at an affordable new 
laptop and Panasonic’s latest 
rugged Toughpad tablet. 
Whatever you use your PC for, 
there’s something for you!

Nick Odantzis deputy editor
nick.odantzis@futurenet.com

Welcome

how we review
One of the key tenets of our 
review philosophy is that 
hardware should be compared 
against like products wherever 
possible. It is only when you pit 
the finest products of a certain 
type against one another – at 
the same time – that you can 
really come up with a definitive 

verdict as to which is the very 
best in that category. The pace 
of development in computer 
hardware means that it is very 
difficult to compare scores 
from today with those from, 
say, six months ago. Magazines 
and websites that review a new 
product on its own run the risk 
of confusing or misleading.

We guarantee to test every 
piece of hardware rigorously 
and thoroughly, using only 
acknowledged experts to 
establish the worth of a 
product. We always review 
from the viewpoint of our 
readers; the day-to-day 
practicality and quality of  
a product is paramount.

We use only acknowledged experts to review products, so you can use 
our ratings with full confidence to make your buying decision

ratinG explained Superb GoodVery good Disappointing Poor

our awards…Our review guarantee
Only the very 
finest products 
receive our Best 
On Test Award. 
These will have 
excellent marks 
for quality.

Our Best Value 
Award is given 
to products that 
quite simply 
represent the 
best value for 
your money.

88 Firefall
Strap on your jetpack and step into the 
boots of a soldier of fortune operating in 
a post-cataclysmic Brazil.

80 Mini test: music streamers
Get your music sorted with affordable Wi-Fi 
enabled slabs and premium all-in-one 
devices for every room in your house.

90 Risen 3: Titan Lords
The nameless hero of the Risen series 
returns as an undead pirate, hunting 
demons alongside power-mad mages.

82 Nokia Lumia 930
With an iconic design and wireless charging, 
this is the best Windows phone we’ve seen 
and a serious challenger to iOS and Android.
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Upgrade 
What’s inside…

You can trust our reviews
Our expert reviewers are 100 per cent 
independent, with years of experience 

in the world of computing. Our rigorous 
testing procedures mean that only 
genuine, high-quality products are 
awarded high star ratings. Further, very  
few are handed our Best Value or Best  
on Test Awards. If you see an item of 
hardware bearing one of these marks,  
you can be confident that it is an excellent 
product. Always check when the award  
was given, to ensure it is still up-to-date.

we choose the best products
Thousands of new products for your 
computer are released every year and 

choosing between them can sometimes be 
an impossible task. Our experts select only 
the best hardware and software to feature 
in this magazine, making your decision on 
which one to choose easier. Even better, 
our awards and star rating system make it 
simple to find the best products for your 
needs, with our recommended products 
section giving you a fast, trustworthy guide 
to a wide range of hardware and software.

we’ll introduce you to new stuff
Wherever we can, we review new 
hardware comparatively, pitching  

it head-to-head against other similar 
products. (Full details of our policy can be 
found in the opposite page, under ‘Our 
review guarantee’.) Of course, this isn’t 
always possible with new products and 
part of our duty to you is to introduce you 
a wide range of fascinating new hardware, 
software, services and games.

The reviews of standalone hardware  
and software are just as thorough as our 
comparative reviews. However, we do not 
allocate scores to them because this can 
often be misleading. The only exception to 
this rule is on our games reviews, where 
the pace of change is a lot slower and 
single scores can be genuinely useful.

The Upgrade section is your key to finding out about the latest 
products, all designed to help you get more from your PC

“This is a very uncomfortable game  
to play. It demands cold decisions in  

awful situations and shows the results  
with the heartless edge of a rusty scalpel.” 

Turn to page 94

80 Arcam MiniBlink
80 Crystal Audio WiDac
80 Monitor Audio Airstream S300
81 Simple Audio  
Roomplayer with Amp
81 Elipson Planet LW  
with Audio Bridge
82 Nokia Lumia 930
84 PC Specialist UltraNote II
86 Panasonic Toughpad FZ-M1
88 Firefall
90 Risen 3: Titan Lords
92 Warface
94 Gods Will Be Watching
95 Magic 2015 
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an affordable 
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86 Panasonic Toughpad FZ-M1: 
a rugged tablet with serious power
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 Stream,  
baby, 
Stream
Get your home music 
network sorted with cheap 
Wi-Fi slabs and premium 
all-in-ones for all rooms

1 Arcam  
MiniBlink
Price £90 | $149 (www.arcam.co.uk)

Bluetooth is supported by all mobile 
and most desktop devices, and sounds 
good – especially if using the aptX 
variant. It’s pretty stable, too. This Arcam 
aptX dongle provides an easy way to 
get quality sound from your tech to 
your existing hi-fi, and must be the 
cheapest thing the company has ever 
put out – and the least battleship-sized, 
too. We don’t think Apple’s celebrated 
designer Sir Jony Ive is going to be 
looking to his laurels as far as the design 
goes, but it’s sonically impressive, giving 
a notable boost to Bluetooth audio 
compared to cheaper dongles. No 
digital out seems a bit stingy, mind.

2 Crystal  
Audio WiDac
Price £59 | $na  
(www.crystalaudiovideo.com)

AirPlay has perhaps not been quite 
the success Apple hoped, as expensive 
speakers and issues with compatibility 
and stability have pushed punters 
towards Bluetooth. This cheap AirPlay 
dongle longs to right that wrong.

It’s easy to set up, and if your router 
likes it, you can get very good musical 
results. We tried it with both a solid 
speakers-and-amp combo and a frankly 
excessive Geneva XL, and it more than 
held its own. However, if your router 
doesn’t get along with it – and two of 
ours didn’t – it just doesn’t work, which 
makes it difficult to recommend.

3 Monitor Audio 
Airstream S300
Price £249 | $na 
(www.monitoraudio.co.uk)

Another old UK dog learning new 
digital tricks, Monitor here serves up a 
splendid AirPlay speaker. The curved 
S300 can sound pretty refined for a 
£249 dock if you set it up as intended, 
firing out tones to determine its position 
in the room and decide sound settings. 
Alternatively, it can be pleasingly 
raucous and boomboxy if you cheat a 
little by having it self-calibrate while it’s 
sitting right in the middle of a room. 
Wireless setup is a pain in the rear, but 
once done the audio is pretty killer 
(for the price) and stability good (for 
AirPlay). All in all, a nice box.

there’s now a multitude of ways to get 
your tunes out from your smartphone, 
PC or NaS drive and into your home’s 
most cavernous spaces. bluetooth 
connectivity offers simplicity, airPlay 
adds sophistication and multi-room 
capabilities, and there are proprietary 
systems for audiophiles. you can have 
dongles for your stereo, streaming 
amps for your speakers, or an all-in-
one. What’s your dream streamer?

1
2

3
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4 Simple Audio 
Roomplayer 
with Amp
Price £500 | $na  
(www.simpleaudio.com)

Taking on Sonos’s popular Connect: 
Amp is Simple Audio’s own proprietary 
multi-room streamer and amplifier – 
just add speakers. It supports 24-bit 
audio, but lacks a few features, most 
notably wireless connectivity. That’s 
right – you must plug this box in via 
Ethernet/powerline AV. Setup is easy 
and audio is great, so long as it’s paired 
with decent speakers. A non-wireless 
system that costs over £1,000 per room 
with speakers is clearly not to all tastes, 
but the sound is fantastic. 

5 Elipson Planet 
LW with Audio 
Bridge
Price £1,399 | $na (www.elipson.com)

This spherical mini-system comprises a 
brace of wireless, magnificent-looking, 
and sounding, studio-quality active 
speakers… and an uninspiring plastic 
bridge that adds a few inputs to the 
Planet LW’s core Bluetooth connection. 
As ever with good ol’ Bluetooth, pairing 
is easy and stable so long as you 
don’t stray far away. The LW sounds 
fabulous, even if there is a lack of really 
tremendous bass. The price is incredibly 
high, but that’s to be expected when a 
product straddles  the ‘lifestyle’ and 
‘audiophile’ markets like a colossus.

The actual plugs may employ design 
tropes generally left behind with the 
Soviet Union’s demise, but powerline AV 
Ethernet is a godsend for AirPlay and 
systems like Sonos and Simple Audio. 

Accessory: 
powerline AV

4

5
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Windows Phone is going 
on four years old now – 
and it’s still never had the 

standout phone that shows it can 
compete with the iPhone and the 
best Android has to offer.

The Nokia Lumia 930 could be 
that phone, with a next-generation 
screen, an improved processor and 
a new version of the OS to give you 
more options than ever.

This is still a Nokia phone, despite 
the buyout by Microsoft, and the 
heritage is plain to see with the 
choice of coloured plastic backs 
combined with metallic trim.

But here’s the key question: does 
the Nokia Lumia 930 have what it 
takes to rival the key players? It  
certainly has better specifications 
than ever, a great camera, and is 
sporting a lower price tag than the 
competition too.

Playing catch-up
But there’s another side to it: 
the Lumia 930 is using last year’s 
components and still has to battle 
against the fact that Windows 

Phone is still running behind iOS 
and Android in terms of popularity 
and app development.

The first thing that you’ll notice 
is that impressive display. Yes, the 
Lumia 1520 had a 1080p screen, but 
it was much bigger than the 5-inch 
version on show here and was 
therefore less sharp. The AMOLED 
display used on the Lumia 930 is 
just brilliant. Whether it’s the deep 
blacks, rich contrast or generally 
great colour reproduction (which 
Nokia has nailed with its ClearBlack 
technology) the screen quality 
makes for a really lovely experience.

One of the key benefits of OLED 
technology is the fact that when 
a portion of the screen is black, 
it’s completely switched off. This 
means that the difference between 
bright white sections and darker 
portions is more apparent, and 
from the moment you switch on 
the Lumia 930 you get the sense 
that this is a good quality phone.

Nokia’s camera heritage has been 
a mainstay of the mobile phone for 
nearly a decade now. The Pureview 

sensor on the Lumia 930 is similar 
to that seen on the Lumia 1520, 
which is a shame, as we were 
hoping for something really 
advanced that would outstrip it, 
Still, it’s still definitely one of the 
best phone cameras on the market.

Here and now
Another of Nokia’s big strengths 
is the Here suite of products, which 
it bundles with the Nokia Lumia 
range. The big hitters are Here 
Maps and Mix Radio, with the 
former now offering the ability to 
take maps offline. It’s a much better 
app than it used to be; you still 
need to download plugins to make 
it fully functional, but it allows for 
easy mapping and is arguably a 
better sat nav option than those 
from Apple or Google.

However, it’s still not up to the 
standard of Google Maps, either in 
interface or general functionality. 
What you gain in offline capability 
and relevant information you lose 
in the user interface – the slower 
way of flicking through the map 

Nokia Lumia 930
£500| $800 www.nokia.com

Windows Phone brings the fight to Android and iOS
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the level of its rivals – iOS and 
Android – which limits the impact 
of any significant gains made in 
terms of hardware.

It’s a shame because we really 
like Windows Phone as a concept. 
We love having new information 
appear on the home screen’s Live 
Tiles. We like the powerful yet 
simple interface, and we think a lot 
of the changes made in Windows 
Phone 8.1 are really clever. In some 
cases they’re even better than what 
the two main mobile operating 
systems are capable of.

But in so many other areas it’s 
an OS that’s lacking, and surely 
Microsoft knows that. Instead of 
running through the list of apps 
that the competitors have and 
trying to match it, why not start 
making the top 20 apps better than 
they are on Android? There are 
some that genuinely impress us, 
and we want to see more. 

The Nokia Lumia 930 is the 
best Windows Phone yet – you’ll 
probably read that across the web. 
The build quality is excellent, the 
design is iconic, and the camera is 
powerful enough to produce some 
truly great snaps. We like the fact 
that the base model provides 32GB 
of storage, and the built-in wireless 
charging is perfect.

The price is pretty good too, and 
if you’re a fan of Windows Phone 
there is nothing better right now. 
But Microsoft needs to boost the 
interface and usability of its OS as 
soon as possible to make sure it 
keeps up with pack – and that’s 
the main thing that’s troubling the 
Nokia Lumia 930 right now. ■

The most complete Windows 
Phone to date, and the first to 
truly challenge Android and iOS.

(even with the Nokia Lumia 930’s 
powerful processor) shows that it 
still needs more work.

Mix Radio is an interesting 
proposition. The idea is that it 
serves you new music (for free, 
which is brilliant) and even lets you 
sync offline without paying any 
more. The range of genres and 
pre-mixed playlists is great, and 

despite downloading Spotify as 
well (which needs a lot more work 
on Windows Phone), we found 
ourselves more drawn to this app 
to see what music was on offer.

However, it didn’t take long to 
start to fall out of love, as it relies 
on you having a data connection 
most of the time, and you lose a lot 
of functionality if the signal drops.

You can pay £3.99/$3.99 per 
month for extra features, such 
as improved audio quality and 
unlimited skips through songs, but 
the premium version isn’t much 
better than the free app. You also 
need to sign up through a Nokia 
account (it’s not yet fully integrated 
with Microsoft accounts) which 
seems a bit last decade.

There are plenty of other great 
apps from Nokia and Microsoft 
though – everything from Video 
Tuner (which allows you to easily 
make more shareable videos) to 
Nokia Beamer (an awesome app 
that lets you mirror your phone 
screen on any internet-connected 
device in the world), all of which 
help make the Nokia Lumia 930 a 
more enticing prospect. 

Nokia has also chosen to equip 
the new Lumia 930 with wireless 
charging technology, which has 
apparently added a lot of weight to 
the handset. The tech has been an 
optional extra in other recent Nokia 
models, with snap-on cases giving 
users the option to sacrifice the 
convenience for a lighter phone 
depending on their priorities.

Despite our misgivings about 
having it forced upon us, it’s very 
handy, and even better that there’s 
a wireless charging pad in the box 
– that’s what consumers need to 
make wireless charging happen. 
Simply plug the pad into your 
computer’s USB port and place 
your phone on top whenever its 
battery needs a boost.

We don’t see why the technology 
has added so much depth to the 
phone (assuming that’s the reason), 
as other models, such as the LG G3, 
can manage it in a very slim profile. 
Nevertheless, wireless charging is 
a real advantage. Not needing to 
plug your phone in for the first time 
as you put your head on the pillow 
is really awesome – this is the kind 
of futuristic experience we’ve been 
looking forward to for years.

Pros and cons
The Nokia Lumia 930 is a really 
great device that’s hampered by 
a few too many drawbacks that 
hold us back from lauding it as a 
truly standout handset.

The main reason is because 
Windows Phone still hasn’t reached 

“The build quality is excellent, the design is iconic, 
and the camera produces truly great snaps”

Upgrade 
Nokia Lumia 930
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KEY FEATURES

Nokia Lumia 930 
Primary camera 20MP, PureView
Display size 5in
Display resolution Full HD  
(1,920 x 1,080)
Processor Qualcomm Snapdragon 800
Maximum talk time (3G) 17.9h
Battery capacity 2420mAh
Wireless charging Built-in 
Dimensions 137 x 71 x 9.8mm
Weight 167 g



The UltraNote II is a 15-inch 
mid-range laptop from PC 
Specialist, a British system 

builder that has been producing 
mobile and desktop PCs for what 
seems like forever.

An analogy that could sum 
up the UltraNote II is that it’s the 
unremarkable middle kid of laptop 
designs. Neither the cheapest, nor 
the most expensive; not exactly 
powerful, but not particularly 
underpowered either. Almost every 
aspect of it fits squarely between 
costly high-end systems and 
inexpensive mobile computers.

Mid-level
The analogy can be extended to 
its design too. At 2.2kg it’s not 
especially light, but not ridiculously 
heavy, and its 25mm chassis is 
neither chunky nor ultra-thin. The 
black and dark grey plastic chassis 
doesn’t look bad at all. It has an 
executive-style gunmetal grey lid, 
although it’s fairly bland, with no 

real distinguishing features – not 
even a company logo or branding.

This middle ground is exactly 
what PC Specialist is targeting – 
at least with the configuration 
we received. The UltraNote II is a 
machine for people who are willing 
to pay for a laptop that’s not merely 
sufficient, but gets the job done 
well, at least when it comes to basic 
computing tasks. There’s a range of 
options, starting at £387 including 
VAT for a low-end model, but the 
unit sent to us was configured with 
a few select upgrades that bumped 
the price up to £516.

A 2.6GHz dual-core Intel Core 
i3-4110M processor runs the show, 
with a generous 8GB of DDR3 
memory. Graphics are powered by 
Intel’s HD4600, a chip that lacks 
the sheer gaming grunt of the Iris 
range, but still functions reasonably 
well. The 15.6-inch screen was 
upgraded from the base 1,366 x 
768 option to a 1,920 x 1,080 IPS 
display. It has a matte finish too, 

which is great news if you’re one 
of the many people who dislike the 
reflectivity of glossy displays.

Tough choices
There’s no option of discrete Nvidia 
or AMD graphics for added gaming 
performance. For that, you’ll want 
to look at PC Specialist’s Cosmos II 
range. But you can choose a smaller 
display if you like, since there’s a 
14-inch version of the UltraNote II. 
Preference of screen size is like 
choosing between Pepsi and 
Coke – a purely personal decision. 
We tend to choose portability 
over added screen real estate, but 
equally, some people are happier 
with extra desktop space.

PC Specialist didn’t bother with 
an SSD in this review sample, but 
if we were buying this laptop, we 
would have paid a bit extra to 
include one. If you’re not familiar 
with developments in the storage 
technology industry over the last 
few years, SSDs are a replacement 

PC Specialist UltraNote II
£516 | $na www.pcspecialist.co.uk

A portable and affordable mid-range notebook with good all-round performance

84  |    |  December 2014 December 2014  |    |  85



this trend with the UltraNote II. 
Typing on it is generally fine, and 
won’t lead to frustration.

3DMark scores weren’t great. In 
Fire Strike, the most taxing of all the 
tests, the UltraNote II managed 571 
points. This is considerably less 
than the 693 points achieved by 
the Asus UX301LA and its more 
powerful Intel Iris GT2 graphics.

A big difference between 
particularly thin and light laptops, 
such as Ultrabooks, and the PC 
Specialist UltraNote II is the power 
consumption of the chipset and 
processor. For a device to be called 
an Ultrabook, Intel stipulates a 
minimum battery life. To achieve 
this, the processor has to consume 
as little power as possible. The 
U-series of Intel Core processors, 
as used in the UX301LA, draw less 
than half the power (15W) of the 
Core i3-4110M (37W).

So it’s to be expected that the 
UltraNote II falls down slightly on 
battery life. Three hours 58 minutes 
in PCMark 8’s battery life test isn’t 
great, although it’s far from the 
worst result we’ve ever seen.

The performance results, price 
and general feel of the UltraNote II 
point to one obvious conclusion. 
You could spend a lot more on 
something much more powerful, 
with a longer lasting battery and 
a far nicer design. Or you could 
spend slightly less, and end up with 
a far worse computer in every way.

Sure, it’s not terribly exciting, but 
what you do get with the UltraNote 
II is more than just acceptable. It 
gets the job done, and does so at a 
very reasonable price. ■

Sure, it’s not terribly exciting, but 
this is a good quality, affordable 
option for everyday use.

technology for traditional hard 
disks. They make a huge difference 
to the overall performance of a 
computer, since they feed data 
to the system much quicker than 
a mechanical, spinning hard disk. 
Applications load faster, and 
Windows boots quicker.

The storage section of the 
UltraNote II’s configuration page is 
chock full of options, with larger 
hard disks, hybrid disks, and a 
range of full-sized SSDs from Intel, 
Samsung and Kingston, with 
capacities up to 960GB. You can 
also add an SSD to its mSATA slot, 
to be used in conjunction with a 
hard disk. We’d pick out a 128GB 
Plextor PX-128M5M, which adds 
less than £50 to the final price.

A DVD writer is built in, along 
with two USB 3.0 and two USB 2.0 
ports. Separate line-out and 
microphone analogue audio 
outputs are also present, with 
a 9-in-1 card reader. This is all 
standard for 15-inch laptops, 
although it’s nice to see a generous 
array of USB ports.

Along with a Gigabit Ethernet 
port, the basic wireless networking 
option is an Intel wireless adapter 
that only provides 2.4GHz 802.11n, 
but you can opt for a better variant 
that supports 5GHz, and 802.11ac.

Windows 8.1 comes as standard, 
or you can have Windows 7 if you’d 
prefer. A £79 saving is possible if 
you can transfer a license from 

another computer, or feel brave 
and fancy giving Linux a go instead.

Simple but effective
If any single part of the UltraNote II 
summed up how we feel about 
the entire laptop, it would be the 
trackpad, which is fine, but feels 
fairly generic. A simple mid-sized 
area with two buttons at the 
bottom, it won’t win a prize for 
design, but equally it won’t cause 
problems for its users.

The same applies to the 
keyboard. It’s tough to find any 
laptop these days that doesn’t have 
an isolation-style keyboard, and PC 
Specialist has (sensibly) adhered to 

“A machine for people who want a laptop that’s not 
merely sufficient, but gets the job done well”

Upgrade 
PC Specialist UltraNote II
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KEY FEATURES

PC Specialist UltraNote II
Operating system Windows 8.1
Processor 2.6GHz Intel Core i3-4110M 
Storage 500GB HDD
RAM 8GB DDR3
Graphics Intel HD4600
Display 15.6in, 1,920 x 1,080 IPS
Connectivity 802.11n, VGA, HDMI,  
2x USB 3.0, 2x USB 3.0, Gigabit Ethernet, 
9-in-1 card reader
Weight 2.2kg
Dimensions 374 x 252 x 14mm



Unveiled at this year’s 
Consumer Electronics Show 
in Las Vegas, the Panasonic 

Toughpad FZ-M1 is a rugged 
Windows 8.1 tablet that arrives 
in the mould of the company’s 
10.1-inch FZ-G1, only in a more 
portable 7-inch package. It runs the 
full version of Windows 8.1 rather 
than the cut-down Windows RT, 
meaning it can run your favourite 
desktop programs in addition to 
apps from the Microsoft store.

Like the much larger Toughpad 
4K that sits above it in Panasonic’s 
ever-expanding Toughpad range, 
the FM-Z1 has been for exceptional 
durability. Aimed at businesses and 
anyone else who needs a robust 
tablet capable of taking more than 
a few knocks and scrapes, the 
Toughpad FZ-M1’s chunky looks 
and higher price tag place it in 
an altogether different category 
to slender small tablets such as 
Apple’s iPad Mini 2 with Retina and 
Google’s Nexus 7.

This kind of durability certainly 
doesn’t come cheap, with a starting 
price of £1,183 or $2,099, but if you 
need both mobility and toughened 
design in a small-screen tablet, 
in addition to the ability to run 
both legacy desktop programs 
and Windows 8.1 apps, this is 
undoubtedly the device to beat.

Design and display
With its tough rubberised edges 
the FZ-M1 isn’t exactly glamorous, 
but it’s by no means ugly; we’ve 
certainly seen much less attractive 
rugged tablets. It measures 18mm 
thick – around the same as laptops 
that are a little too chunky to be 
classed as Ultrabooks – and it 
possesses a solid, muscular feel in 
the hand. At 540g, it’s lighter than 
you might expect considering the 
level of ruggedisation on offer.

The display is surrounded by two 
bezels. The first is a magnesium 
alloy chassis on the inside that 
houses the Panasonic logo, the 

Windows logo (which you can 
tap at any time to access the 
Start screen), LED power and 
battery status indicators, and a 
720p front-facing webcam. The 
device also sports a 5MP rear 
camera, which can be upgraded 
to 8MP if you’re a keen snapper.

This is surrounded by a matte 
black outer bezel that forms part of 
the tablet’s protective outer casing, 
and holds the power and volume 
buttons. The display sports a 
resolution of 1,280 x 800, which has 
proved a common choice on many 
Windows tablets released in the 
past year. A pixel-per-inch (PPI) ratio 
of 216 means that text is sharp and 
clearly legible, but not quite on the 
same level as Apple’s iPad Mini with 
Retina (326 PPI). For the FZ-M1’s 
vastly different intended use cases, 
this is to be expected. Readability 
is helped by the display’s high 
brightness levels of 500 cd/m2, 
which is bright enough for outdoor 
viewing – essential in a tablet 

Panasonic Toughpad FZ-M1
£1,183 | $2,099 www.panasonic.com

A powerful yet rugged 7-inch Windows tablet for great performance on the move
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– including 802.11 a/b/g/n/ac Wi-Fi, 
Bluetooth 4.0, one USB 3.0 port, 
a micro SDXC card slot, docking 
connector and optional 4G LTE. It’s 
also available with dedicated GPS, 
Ethernet, serial port and NFC.

The Micro SD and micro SIM 
slots are tucked away behind a 
protective door in the battery 
compartment, and a connector for 
a vehicle dock can be found along 
the bottom edge.

Tough customer
The FZ-M1 is MIL-STD-810G 
certified, meaning it can withstand 
drops of up to five feet and is 
protected against shock, vibration, 
altitude, humidity and extreme 
temperatures, according to 
Panasonic. It’s also the first tablet of 
its type to sport a fanless design, 
allowing it to meet IP65 standards 
for rain and dust. It’s impossible to 
detect any flex anywhere on the 
device, such is its construction.

However, while it’s certainly 
durable, simply being carried 
around in a bag for a couple 
of weeks caused the tablet to 
accumulate a few minor but 
permanent dents in the screen. 
It goes to show that while the 
device is unlikely to break, the 
display isn’t guaranteed to remain 
free from cosmetic damage. ■

Panasonic’s Toughpad FZ-M1 is a 
solid tablet in terms of both build 
quality and performance.

designed for rough-and-tumble 
use on the move.

The display features 10-point 
multi-touch, which provides a 
convenient way of interacting with 
apps and the desktop. The screen is 
a little too small to prod at desktop 
elements comfortably, and if that’s 
something you’ll be doing often, 
you’ll want to opt for the optional 
Touch Screen Pen that attached 
via a removable tether cord and 
provides pinpoint accuracy.

Our model came with Windows 
8.1 Pro (64-bit) installed, which is 

available alongside a Windows 7 
downgrade option (although the 
newer, touch-optimised operating 
system is a much more logical 
choice for a tablet). Internally, the 
FZ-M1 is powered by a dual-core 
Intel Core-i5-4320Y vPro processor 
clocked at 1.6GHz that’s backed 
up by 4GB of RAM (upgradable to 
8GB, which was the configuration 
of our test model). The device is 
also available in another version 
featuring a Celeron low-power CPU 
that runs standard Windows 8.1 
rather than the Pro edition.

Performance
The FZ-M1’s nippy 128GB SSD 
showed no discernible slowdown 
as we poked, prodded and swiped 
our way through Windows 8.1’s 

array of charms and menus, 
opening apps and streaming 1080p 
YouTube video. Usage remained 
smooth even with video playing in 
the background and 10 tabs open 
in Google’s Chrome browser. After 
a fresh install of Windows, 82.3GB 
is available on the device, which 
may be a little on the small size 
depending on how many apps and 
files you want to store (a 256GB 
version is also available).

The CPU is a low power variant 
of Intel’s latest generation (Haswell) 
Core i5 processor, which possesses 

a power consumption of just 4.5 
watts, removing the need for a 
fan to keep temperatures down. 
Panasonic used passive cooling 
techniques to ensure a fanless 
design, as the inclusion of a fan 
would have led to a hole in the 
device, making it impossible to 
waterproof. The machine is 
incredibly quiet as a result.

Something that might be 
a concern when it comes to 
productivity is the device’s average 
battery life. Our PCMark 8 battery 
life test eked just short of six hours 
out of the device before it gave up 
the ghost, meaning you’ll need to 
carry around a swappable spare 
battery to achieve all-day usage.

The FZ-M1 offers a healthy 
amount of connectivity options 

“It’s the first tablet of its type with a fanless design, 
allowing it to meet standards for rain and dust”

Upgrade 
Panasonic Toughpad FZ-M1
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KEY FEATURES

Panasonic  
Toughpad FZ-M1
Supplier www.panasonic.com
Operating system Windows 8.1 Pro 
64-bit (Windows 7 downgrade optional)
Processor Intel Core i5-4302Y vPro
Storage 128GB SSD (256GB optional)
RAM 4GB (max 8GB)
Graphics Intel HD 4200
Camera 2MP front, 5MP rear (8MP 
optional)
Connectivity Wireless-AC 7260 Wi-Fi, 
Bluetooth 4.0, Ethernet, 1x USB 3.0, line 
out, port replicator connector (3G/4G 
mobile broadband, GPS, dual antenna 
connector, HF RFID optional)
Expansion MicroSD (smartcard reader 
optional)
Weight 540g
Dimensions 203mm x 18mm x 132mm
Screen size 7in
Display resolution 1,280 x 800



hub containing an arena, 
designed for players to let off 
steam between missions and 
activities. However, where the 
in-game displays and banners 
advertise a fully featured team 
competition, the reality is 
an unstructured free-for-all, 
where the few who show 
up take potshots at each 
other before and wandering 
off. Mostly it sits empty – a 
symbolic beacon of Firefall’s 
troubled development.

That’s a shame, because 
sometimes you get a hint of 
what it should have been. 
There’s frantic fun to be had 
dodging and weaving with 

Players wanted. Must like long walks with little reward
Price Free
Developer Red 5 Studios
Publisher In-house  
Multiplayer Massively  DRM Account log-in  Web www.firefallthegame.com
Recommended specs Dual-core CPU, 4GB RAM, 1GB VRAM GPU

your jetpack, avoiding fire and 
clearing out hordes. Firefall 
contains the suggestion of a 
solid shooter, and occasionally 
it rises to the surface.

Set primarily in Brazil, 
Firefall depicts a world that’s 
witnessed more than its share 
of cataclysm. First there was 
the Firefall itself: an asteroid 
shower that devastated much 
of the planet. More relevant to 
the main plot is the Arclight, 
an interstellar spaceship that 
crashed into Earth on its 
maiden voyage. Its flaring 
engines pulled through 
a strange purple death cloud 
from an alternate dimension. 

Firefall is a free-to-play 
MMO shooter with an 
emphasis on dynamic 
events, skill-based 

combat and desperate defence 
against overwhelming enemy 
forces. All of which sounds 
promising, but there’s a lack 
of variety, constant busywork 
and a set of interconnected 
systems that sit awkwardly 
against the drudgery of the 
game. It has potential, but in 
almost every way, it fails to 
meet the ideal it’s trying to sell. 

The single greatest example 
of this – at least during the 
30 hours that I’ve played – is 
found in Sunken Harbor. It’s a 

Firefall This is the Melding, from 
which emerged the Chosen 
– the humanoid beings now 
trying to wipe out humanity. 

Aero dynamics
This is the backdrop against 
which you operate. As a 
mercenary, the invasion of 
the Chosen is, at first, only 
tangentially related to your 
operations. The war provides 
plenty of opportunities to pick 
up work, so most of your time 
is spent taking on missions 
from each hub’s job board. 
These offer a variety of 
scenarios in which you go to a 
place to kill things. Sometimes 
you kill things while defending 
a person, sometimes you kill 
things while collecting items, 
and sometimes you kill things 
because they need killing.

Each job is accompanied 
by dialogue between your 
handler, Aero, and your 
temporary employer. Some of 
them form multi-part quest 
chains that span multiple 
hubs. At each new area, I 
made sure to pick up any 
missions involving a rogue 

 Enjoy the view – it might be 
 the best part of the mission 
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named Wiley, who’d had 
dealings with my callsign’s 
last owner. It was a fun little 
mystery sprinkled throughout 
the game. But aside from this, 
and a few other exceptions, 
conversations waver between 
incidental and annoying. Aero, 
in particular, has a jarringly 
moralistic edge. She’ll 
repeatedly tell NPCs you’re not 
a contract killer, which rings 
somewhat false.

From its opening to its 
sparse endgame (currently a 
dedicated player-vs-player 
zone and couple of raid 
bosses), Firefall is an awkward 
mix of shooter and MMO that 
lacks the breadth of systems 
needed to keep things fun.

The few times a mission 
does try something different, 
it can go badly wrong. For one 
job, I was required to disguise 
as a bandit. This happened 
without warning after a 
combat objective, leaving me 
close to death and without my 
abilities, jetpack or health 
regeneration. After I inevitably 
died, I respawned at the quest 
hub with the disguise still 
intact – forced to sprint back 
to the objective without 
access to my vehicle.

When not on a job, you’ll 
stop at a dynamic event. These 
range from small solo missions 
to harder group activities. 
There’s little to distinguish 
these from the regular quests 
(you’re still travelling to an 
area to fend off bugs, bandits 

or Chosen) but many require 
you to hold out against waves 
of enemies, and this structure 
provides the best showcase 
for Firefall’s combat.

At the start, each player has 
access to five Battleframes. 
These lightweight mech suits 
function as your class, and can 
be swapped at a Battleframe 
Station. Experience points 
go towards improving your 
equipped frame, so while 
experimentation is possible, 
it’s more effective to stick with 
a single type. The Battleframe 
defines your weapons and 
abilities, and – while all are 
useful in combat – some have 
the edge in terms of how 
enjoyable they are to play.

The minigun of the 
Dreadnaught and the scoped 
automatic rifle of the Recon 
are particularly dull. I grew 
more attached to the plasma 
grenades of Assault class’s 
cannon, which required me to 
be consistently accurate on 
the move. It doesn’t match the 
satisfying skill level required 
by Tribes: Ascend’s Thumper 
DX or Spinfusor, but it offered 
a challenge that dragged me 
through the game’s repetition.

Each frame can equip 
abilities to the first four slots 
of the hotbar. Engineers 
place turrets, Biotechs deploy 
healing spells, and Assaults 
slam to the ground, doing 
huge damage to the collected 
enemies below. The best 
example of this are squad 

‘Thumps’. These are resource 
collection events, and can be 
called down by players to any 
location. Personal Thumps 
offer a challenge, but it’s the 
craftable squad versions that 
provide some of the game’s 
most engrossing battles.

Where to?
If that sounds like unqualified 
praise, know that the event 
system is unsupported by the 
way players travel across the 
map. Melding Tornadoes are 
interesting – group battles 
against a swirling, purple, 
Chosen-spawning twister. It’s a 
call to arms for players, with 
coordinates shared over zone 
chat when one appears. 
Except, even knowing where it 
is, it can be difficult to reach. 
You can teleport to mission 
hubs, but doing so costs 
Credits – a currency I was 
never comfortable wasting. 
You must therefore walk or 
drive, the latter only an option 
if you’ve bought a vehicle with 
real money or crafted one 
following a level 25 mission. 
Most Tornadoes had vanished 
by the time I’d arrived, or were 
empty, leaving me no hope of 
finishing the encounter.

This is Firefall’s other major 
failing: it doesn’t respect your 
time. It looks nice, but those 
views don’t justify how long 
you’ll spend sprinting from 
location to location. In one 
early mission, I was asked 
to trek north to meet a 

character. When I arrived, they 
asked me to turn around and 
head back. It’s so absurd it’s 
actually funny, but it highlights 
a persistent flaw.

The real money store is 
largely stocked with cosmetics 
and XP boosts. It’s not ‘pay to 
win’, but it’s skewed so that 
the non-paying options take 
more time than they’re worth. 
Crystite, the basic in-game 
currency, is earned slowly, and 
is largely swallowed up by 
researching crafting options. 
This is a slow process – crafting 
actions are performed on a 
timer that can take anything 
from seconds to days. That 
timer can be bypassed by 
paying real money. 

These small inconveniences 
add up. Free-to-play games 
must strike a balance between 
time and money, but here 
it feels off. Not because 
of the contents of the store, 
or the  value of each currency, 
but because Firefall is rarely 
engaging enough to make the 
commitment worthwhile. ■

 Enemies sometimes need a bit of 
 encouragement to start shooting 

 Some weapons are much 
 more satisfying than others 

Squad Thumps have a chance to 
spawn a mass wave of  Chosen

The churn of missions further 
spoils an only occasionally 
entertaining shooter.

Upgrade 
Play this…
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before he’s brought back 
to life by a loopy shaman. 
Piranha revives the series 
along with him, and fittingly 
sends him off in search of his 
soul. It’s a generally fun romp 
that takes him into deep caves 
hiding menacing shadow 
lords, and into bleached 
dreams where he waxes 
philosophical with villains 
from Risen’s past, but happily 
it’s not the kind of game that 
demands encyclopedic 
knowledge of its forebears 
and their characters. Titan 
Lords’ tale of securing the help 
of powerful mages stands 
quite well on its own.

Its hero is dead, but this third instalment brings the series back to life
Price £40 | $50
Developer Piranha Bytes
Publisher Deep Silver  
Multiplayer None DRM Steam Web www.risen3.deepsilver.com
Recommended specs 2GHz CPU, 2GB RAM, GeForce 9600GT / Radeon HD 3850

You can thank the three 
new factions you can align 
with for a lot of that. The 
voodoo of Risen 2 makes a 
return in the camps of the 
‘natives’, but they never steal 
the show quite like their 
neighbours. The Guardians 
serve the mages on their rocky 
isle, but their fighting skills 
(and gear) add a welcome 
edge to the spell-slinger 
faction by leaving them with 
a degree of melee prowess. 
Scowling on stage left, we 
have my fellow Demon 
Hunters, who bring a bit of 
Conan-style grit and grunt to 
the proceedings.

Piranha Bytes knows 
you probably didn’t 
like Risen 2, and so the 
studio symbolically kills 

it off a mere 30 minutes into 
the sequel. There he is – the 
hero of 2012’s pirate-themed 
adventure, still nameless after 
all these years and looking as 
though he just wandered off 
the set of Assassin’s Creed IV. 
But piracy apparently isn’t 
what players want, and so 
he dies in front of a glowing 
portal in a ruin without so 
much as a last “Arr.”

Fortunately, he is risen. His 
corpse spends three weeks 
fermenting in the tropical sun 

Risen 3: Titan Lords Yet more importantly, the 
three factions bring magic. 
This enhances the experience 
of Risen 3 so thoroughly that 
it’s appalling to think that its 
predecessor shipped without 
it. A chief criticism of Risen 2 
was that the tendency of 
enemies to gang up on you 
kept you from attacking, but 
here I send them flying back 
with a spell like the Demon 
Hunter’s Shockwave. While 
they’re wiggling from shock, 
I whip out a crossbow and – 
thoonk thoonk thoonk – they 
collapse like dominoes. It’s 
ridiculously fun. 

Hack and slash
But let’s be candid: it takes a 
while to reach this state of 
combat nirvana. Risen 3 wisely 
isn’t so stingy with gold and 
gear as its predecessor, and 
nor does it leave the locations 
of quest objectives open 
to guesswork, but its core 
combat does rely on the same 
dubious dance of parrying, 
heavy attacks and slashes, 
despite fancy new animations. 
Risen 3 is strikingly bug-free 

 Nothing a little 
 antacid won’t fix 
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considering the series’ 
reputation for glitchiness, 
but sometimes obvious hits 
seem to miss and relentless 
enemy attacks can still break 
seemingly well-timed blocks.

But then this is a world 
where Glory is earned by 
killing chickens, to say nothing 
of mincing undead creatures 
from other dimensions. Glory 
is everywhere, and it’s used 
to boost stats that affect our 
hero’s prowess in skills such 
as Melee or Influence. It’s a 
versatile system, and one 
that enabled me to turn my 
Demon Hunter into a battle 
mage of sorts who wreaked 
havoc with his battleaxe while 
summoning demon dogs. Not 
powerful enough? Buy some 
lessons from folks around 
towns. Toss in consumable 
spells of the crystal and runic 
varieties and companions 
from various factions, and 
you’ll find few situations 
where hope is in short supply.

And situations abound. 
There’s a pleasing balance of 
combat and story, seasoned 
with minigames for 

lockpicking or arm wrestling 
for extra gold. And bless my 
beard, the ship battles! 
Somebody’s definitely been 
playing Assassin’s Creed IV, and 
it’s paid off. Once our hero 
nabs a ship, clashes with sea 
monsters and enemy ships 
begin – just when the rest of 
the game starts to slip into 
a predictable rhythm. The 
versatile mix of broadside 
cannon bursts and races to 
keep powder kegs from 
exploding ensure the concept 
never outstays its welcome.

Any concerns? Well, it’s not 
exceptionally pretty. Frankly, 
Risen looks old. But I still didn’t 
want to stop playing. ■

 I love how my companion is just 
 content to watch this happen 

 “You wanted magic? 
 We’ll give you magic!” 

 Here there be monsters. 
 And you blow them away 

 Good thing Assassin’s Creed IV 
taught me how to do this 

 Alien V. This time 
 they have wings 

 With some creative spell use, you 
 can bring along several helpers 

Combat quibbles and muddy 
graphics do little to spoil the 
fun of this enjoyable RPG.

Upgrade 
Play this…
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Warface is Crytek’s free-to-
play stab at Call of Duty’s 
deathmatch formula, which 
it spreads across multiple 
modes, bundles with a thin 
handful of new ideas, and 
shackles to an ever-present 
storefront. Warface is the 
game you play if you fancy 
running in a circle shooting 
people in the back but don’t 
want to pay full price for 
the privilege – which is a 
reasonable enough notion – 
and is also the game you play 
if you are 10 years old and 
your parents won’t buy you 
something better. I know that 
because the voices I’ve heard 
in-game have, universally, 
been those of children; on one 

Crytek’s free-to-play shooter sets its sights a little too low
Price Free-to-play  
Developer Crytek
Publisher In-house  
Multiplayer Online, co-op and competitive DRM Online only Web www.warface.com
Recommended specs Dual-core CPU, 512MB GPU, 2GB RAM 

occasion I heard someone 
being told off for not doing 
their homework. That brief 
moment of kitchen sink 
drama was the most fun I’ve 
had with Warface – a game 
that is otherwise as blandly 
functional as you’d expect 
the lovechild of two business 
models to be.

Cheap thrills
Warface feels like something 
you played once in a sticky-
floored arcade during a 
half-remembered summer 
holiday. It should smell 
of cigarettes and old carpet. 
It’s low-rent in the way that 
lightgun shooters traditionally 
were, and it’s this, rather than 

Do you remember that 
bit in Call of Duty? You 
know the one I mean. 
You were a guy – a war 

guy – and you ran around a 
corner to find another war 
guy running in the opposite 
direction. Yes! This was your 
moment to shine. You raised 
your RDS and sprayed hot 
5.56mm NATO into his back, 
earning you 100 points, a kill 
and a little shot of dopamine. 

Then, disaster struck! 
Another war guy ran around 
the corner behind you, the 
screen turned red and you 
died. Do you remember? You 
must do, because it happened 
to everybody, everywhere, 
every day, for years and years.

Warface the Call of Duty-shaped 
hole it aspires to fill, that 
gives it a personality. It’s not 
a substantially realised thing 
– it never reaches House of 
the Dead or Area 51’s classic 
daft-but-kitsch territory – 
but it’s something, and when 
Warface’s angry red LED 
damage indicators are 
bursting from the body of a 
stricken foe there’s a little of 
Time Crisis to the experience.

You can press a button to 
slide along the ground on 
your backside and earn bonus 
points for killing someone 
while doing so. One of the 
better modes is like Counter-
Strike with bad maps. There’s 
a capable co-op mode where 
you fight your way through 
a series of themed alleyways 
blasting pigeon-brained AI 
and sometimes tangling 
with helicopters or mechs 
or tanks – an experience that 
scales up through a series 
of difficulty levels and that, 
in its final stages, requires 
some coordination. It’s 
very repetitive, but it looks 
perfectly okay and it’s free.

Warface isn’t terrible – I 
found myself sinking hours 

The best of Warface is in the 
fine tuning of the four classes



92  |    |  December 2014 December 2014  |    |  93

into it – but its successes are 
those of other, better games. 
If you want a modern military 
shooter, you should play 
Counter-Strike: GO. Or Titanfall. 
Or one of the earlier Battlefield 
games. Or Call of Duty. If a free 
competitive game on PC is 
what you’re looking for, look 
further; there are lots. This is 
a game with tame ambitions 
that manages to achieve a few 
of them. There’s merit there, 
I suppose, but not enough to 
warrant a recommendation. ■

 I’m going to shoot at that, 
 even if it’s on my side 

 Shoot the bad guys before they 
 shoot you. Yeah, it’s that simple 

 Just do it 

 I’m pretty sure someone’s 
 mum just told me to go to bed 

 I’m tempted to just shoot 
 out those monster tyres 

A middling contender in a 
packed genre that leans too 
much on being free to play.

Den of confusion
Warface has a safe house that you can visit from the menu. You can’t bring your friends. It is pointless

Three basketball 
hoops
There is a ball here, 
but you can’t pick it 
up. Why do you have 
three of these?

Pinball table
You’ll find a Warface 
pinball table, but 
instead of actual 
pinball it just has a 
big screenshot of the 
game on it. 

Football net and  
so on 
Weights, a football 
net, a camera and 
sofas. A graveyard for 
various useless items.

Sci-fi 
holo-table
Why is there a 
glowing holo-map  
of a featureless hill  
in this run-down 
warehouse?

Upgrade 
Play this…



quiet for a few minutes. But 
will they? No! Shouting at 
them doesn’t help. Darn! The 
computer feed’s been hacked 
again. What now? All this 
messing around has made 
the hostages lose respect and 
openly rebel. There’s a way to 
fix that. Let’s hope their leader 
learns to love hopping.

And so, slowly but surely, 
in a hundred tiny little steps 
down a road paved with good 
intentions, does Gods Will Be 
Watching make you the bad 
guy. Or the mad scientist. Or 
the pragmatic military leader, 
slowed by a wounded soldier. 

This is a very uncomfortable 
game to play. It demands cold 

Gods will be watching, but it’s your job to judge
Price £7 | $10
Developer Deconstructeam
Publisher Devolver Digital  
Multiplayer None DRM Steam Web www. godswillbewatching.com
Recommended specs Core 2 Duo, 2GB RAM, 512MB 3D card

decisions in awful situations 
and shows the results with 
the heartless edge of a rusty 
scalpel. The game itself 
stands back from moralising, 
encouraging you to do it to 
yourself at the end of each 
stage, with a breakdown 
of how everyone else who 
played did – a reminder that 
you could almost certainly 
have done better.

For the most part, it’s very 
effective, squeezing every 
drop of life out of its pixels. 
Where it struggles is that in 
order to stretch out the few 
stories into a commercial 
game, each vignette is 
designed to be challenging, 

This is a game about 
the fact that you’re 
probably not a 
psychopath, but hey, 

sometimes bad stuff happens.  
First scenario: you’re not a 

terrorist. Your hostages may 
disagree, but, as you tell them, 
you’re not looking to hurt 
anyone. They’re just there for 
protection while your team 
hacks a government server.

Then the timer starts. All 
you have to do is keep things 
quiet for your hackers, and 
keep the guards outside the 
door out of flashbang range 
– an instant game over. And 
everything would be fine, if 
everyone would just sit and be 

Gods Will Be Watching even if you take easier – often 
morally repugnant – shortcuts 
like thumping hostages. The 
resulting repetition after 
things go wrong saps the 
emotion of each story, turning 
characters into puzzle pieces.

The scenarios are long 
and can’t be saved, which 
can be a pain if you mess up 
something minor, That aside, 
Gods Will Be Watching is a 
clever idea that is well-
executed. It avoids the overt 
morality of similar games in 
favour of simply asking you to 
judge yourself as you see fit. 
This is a very different kind of 
adventure that will make you 
feel bad, but hopefully for 
most of the right reasons. ■

 Gods have yet to get YouTube 

 I dread to think what you’d 
 consider managing badly 

 Taking hostages is hard. I’m not 
robbing that bank any more 

 Also, the dog!  

An inspired take on the   
‘survival’ genre, where you 
create your own horror. 

 The script can be a bit 
 wonky, but is serviceable 
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behind a huge grind, which 
you can pay to circumvent. 

Formerly, you’d beat bosses 
to unlock themed decks, 
which you could tweak with 
additional cards. In Magic 2015 
you are locked into playing 
with a hybrid starter deck after 
the tutorial. As you progress 
through the campaign – linear 
strings of AI battles divided 
into five ‘planes’– you receive 
booster packs that slowly 
grow your card collection. 
Eventually, you’ll have enough 
to enter the deck creator and 
build something new.

The deck builder allows 
for good customisation, but 

Less jaw-dropping feat of illusion and more financial sleight of hand
Price £7 | $10
Developer Stainless Games
Publisher Wizards of the Coast  
Multiplayer 2-4  DRM Steam Web www.bit.ly/1y1LkOU
Recommended specs 2GHz CPU, 1GB RAM, 512MB GPU

amassing enough cards to 
make interesting use of it takes 
far too long. Each section of 
the campaign has an ‘explore’ 
option that lets you play AI 
battles to win booster packs. 
Expect to use this a lot, and 
expect to unwrap boosters full 
of duplicates and weak cards.

The format seems designed 
to push players into picking 
up card collections, for £4/$5 
per plane, or £27/$38 for the 
whole bunch. If you want full 
access to the variety of Magic 
2015’s cards, you’ll need to pay 
far more than the initial £7/$10.

And then there’s the state of 
the game itself. Menu screens 

For years, the Duels of 
the Planeswalkers series 
produced limited but 
satisfactory versions of 

the classic card game Magic: 
The Gathering. The ballooning 
success of Hearthstone makes 
this a great time to introduce 
new players to the complex, 
highly competitive king of the 
genre. Instead we get a clunky, 
under-featured sequel 
hobbled by microtransactions.

The ruleset is still brilliant, 
and Magic: The Gathering is 
far more challenging than 
anything you’ll experience in 
Hearthstone. Unfortunately 
Magic 2015 locks this potential 

Magic 2015 hiccup during long transitions 
between pages. In matches, 
button-clicks sometimes 
go unregistered and the 
‘Continue’ button has been 
known to freeze in multiplayer, 
mid-match. At best it’s a 
frustrating experience with 
fewer features than its 
predecessors. At worst, Magic 
2015 is a cynical redesign 
created to suck money out of 
players. As such, I’m unable 
to recommend it to anyone at 
all. If you want to play Magic, 
any edition prior to this one is 
more fun. For competitive 
card-duelling, you’ll get more 
out of Hearthstone without 
paying a penny. ■

 Expect to part with your 
 hard-earned cash for more cards  

Magic 2015 seems designed 
to extract money from 
players with little reward.

Upgrade 
Play this…
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Your disc
Hello and welcome 
to your free disc, 
exclusive to 
Windows Help & 
Advice. This month’s 

packed CD-ROM features great 
programs to help you get the 
best from your computer, plus 
essential resources for every 
Windows user.

In addition to a huge array of 
free apps, we’ve included a free 
Windows 7 ebook that you can 
read on any device. Whether 
you’re a newcomer to Windows 
or a seasoned expert, you’re 
guaranteed to learn something 
new and useful. Enjoy! 

Jeremy Ford disc editor
jeremy.ford@futurenet.com

Welcome This issue’s highlights

1 Get started 
Place your free disc into your computer’s disc drive. The 

AutoPlay prompt should appear on your screen and once this  
has happened, click ‘Run OWV.exe’ to start up the disc interface.  
A new window appears, telling you some important information. 
Read it, then click on ‘I agree’ to continue.

2 Browse the categories 
Click on one of the categories in the menu underneath the 

magazine logo to discover all the programs that are contained in 
each. Simply click on an app’s name to find out more about it.  
Full commercial products usually have information about how  
to register. To try out an app, just click the ‘Install Now’ button.

Step-by-step How to use your free disc

20 Use OpenWith to ensure files 
open in your preferred program

13 Solve wireless network issues 
with Xirrus Wi-Fi Inspector

19 Solve common photographic 
issues with Paint.NET

17 Use CCleaner to uninstall old 
versions of programs

 full productS   Handpicked toolkitS   eSSential reSourceS
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Your disc
Make the most of it!

3 install the program 
When you begin to install your chosen applications, the  

disc brings up another message window to take you through the 
installation process. Each one of these is different – just follow the 
prompts until you get a message telling you that the installation 
is complete. Now it’s time to try out your free apps – have fun!

Find the solution! How to get your disc to play
If the disc doesn’t start automatically, hit the [Windows] key, 
then click ‘Computer’. Double-click the DVD drive to get going.

if you have  
a problem…
Please visit www.
futurenet.com/support. 
To contact our reader 
support team, email 
support@futurenet.com 
or call 01225 822743, 
quoting the magazine 
name and issue. We are 
only able to provide help 
with this disc, not the 
software contained on it.

 
101 WindoWS 
proBlemS Solved
•  AdwCleaner
•  Anvi Browser Repair
•  CCleaner
•  DesktopOK
•  DNS Angel
•  DOSbox
•  Driver Identifier
•  Installguard
•  Keyfinder
•  LastActivityView
•  Media Preview
•  OpenWith Enhanced
•  Process Hacker
•  Q-Dir
•  QuickSystemRestore
•  ShellExView
•  ShortcutsMan
•  Touchfreeze
•  Touchpad Blocker
•  UnDeleteMyFiles Pro
•  Windows Error  

Lookup Tool
•  Xirrus Wi-Fi Inspector

GrapHic deSiGn
•  BirdFont
•  Blender
•  Inkscape
•  IrfanView
•  MyPaint
•  Pencil
•  Sweet Home 3D
•  Synfig Studio

extraS
•  AOMEI OneKey 

Recovery
•  AVG AntiVirus Free 2015
•  Filebot
•  Networx
•  Opera Web Browser
•  Paint.NET
•  VirtualXP Free
•  Windows 7 Essentials 

eBook
•  And more!

Full disc  
contents
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